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Unit 1: Surfaces and Materials 

1.1 Main menu bar of 3D software (character’s and objects that are developed on 3D)  
 

Basics 

Maya is the premier application for creating compelling 3D digital content, including models, 
animation, visual effects, games, and simulations. 

The work you do in Maya generally falls into these categories: 

• Creating models. Polygons, Non-Uniform Rational B-Splines (NURBS), and subdivision 
surfaces are different object types with different ways of modeling. Each has its own strengths, 
and different artists prefer working with different types. 

o Polygons let you model a surface by building up and reshaping a number of simple surface 
facets. 

o NURBS let you easily create smooth, curving surfaces with high-level control. 

o Subdivision surfaces let you edit surfaces at a high level with minimum overhead data, while 
still letting you work with subsections of the surface as if they were made from polygons. 

• Character rigging. Most animations involve “characters,” articulated models such as a person, an 
animal, robot, or anything else that moves by articulation. Maya lets you define internal 
skeletons for characters and bind skin to them to create realistic movement with deformation. 

• Animation. Just about everything you can think of in Maya is keyable or able to be animated. 

• Dynamics, fluids, and other simulated effects. Maya includes a comprehensive suite of tools for 
simulating real world effects such as fire, explosions, fluids, hair and fur, the physics of colliding 
objects, and more. 

• Painting and paint effects. Maya includes an incredible system for using a graphics tablet (or the 
mouse) to paint 2D canvases, paint directly on 3D models, paint to create geometry, scriptable 
paint, and virtually limitless other possibilities. 

• Lighting, Shading, and Rendering. When you want to render a still image or movie of your scene 
or animation, you can create them using your choice of renderers. 

Now that Maya is running, you first need to understand what you are seeing. There are a lot of items 

displayed in the Maya user interface. 

The best way to begin is to learn the fundamental tools and then learn additional tools as you need 

them. Begin by learning some of the main tools. 
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The Maya workspace 

The Maya workspace is where you conduct most of your work within Maya. The workspace is the 

central window where your objects and most editor panels appear. 
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When you start Maya for the first time, the workspace displays by default in a perspective window, 

or panel. There are the other components of the default perspective view panel: 

• The panel is labeled persp at the bottom to indicate that you are viewing the Maya scene from a 

perspective camera view. 

• The panel has its own menu bar at the top left corner of the panel. These menus allow you to 

access tools and functions related to that specific panel. 

• The grid is displayed with two heavy lines intersecting at the center of the Maya scene. This 

central location is called the origin. The origin is the center of Maya’s 3D world, and with all 

object’s directional values measured from this location. 
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In Maya, like many other 3D applications, the three dimensions are labeled as the X, Y, and Z axes. 

The origin is located at X, Y, Z position of 0, 0, 0. The grid also lies along the X, Z plane. We refer 

to this as a plane because you might visualize an imaginary, flat, two-dimensional square laying 

along this 3D position. 

Maya labels the X, Y, and Z axes with a color scheme: red for X, green for Y, and blue for Z. Many 

tools that you use in Maya use this color scheme to indicate that you are accessing a particular item 

that relates to X, Y, and Z in some way. 

 

 

The axis indicator shows in which direction, X, Y, or Z, you are viewing the Maya scene. The axis 

indicator is color coded in the red, green, and blue color scheme and appears in the lower left corner 

of a view panel. 

This is extremely useful if you are new to 3D, as many of the instructions in this manual and 

the Maya Help assume you know where you are viewing the scene in relation to the X, Y, Z axes. 
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Main Menu bar 

Tools and items are accessible from pull down menus located at the top of the user interface. In 

Maya, menus are grouped into menu sets. These menu sets are accessible from the Main Menu bar. 

The Main Menu bar appears at the top of the Maya interface directly below the Maya title bar and 

displays the chosen menu set. Each menu set corresponds to a module within 

Maya: Animation, Polygons, Surfaces, Rendering, and Dynamics. Modules are a method for 

grouping related features and tools. 

 

 

You switch between menu sets by choosing the appropriate module from the menu selector on 

the Status Line (located directly below the Fileand Edit menus). As you switch between menu sets, 

the right-hand portion of the menus change, but the left-hand portion remains the same; the left-hand 

menus are common menus to all menu sets. The left-hand menus 

contain File, Edit, Modify, Create, Display, Window, and Assets. 
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To select a specific menu set 

1. On the Status line, select Animation from the drop-down menu. 

The Main Menu changes to display the menu set that relates to the Animation module. In 

particular, menu titles such as Animate, Deform, Skeleton, Skin, and so on, appear. 

2. Using the menu selector, choose Polygons from the drop-down menu. 

The main menu changes to display the menu set for Polygons. Menu titles such 

as Select, Mesh, Edit Mesh, and so on, appear. 

For now, leave the menu set at Polygons. You will use this set in the next step. 

 

To create a primitive 3D object from the Polygons menu set 

1. Select Create > Polygon Primitives > Interactive Creation and ensure that a check mark does not 

appear beside this item. 

For this lesson, you won’t use this option. 

2. From the Main Menu Bar, select Create > Polygon Primitives > Cube. 

Maya creates a 3D cube primitive object and places it at the center (origin) of the Maya 

workspace. 

 

 

Status Line 

The Status Line, located directly below the Main Menu bar, contains a variety of items, most of 

which are used while modeling or working with objects within Maya. Many of the Status Line items 
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are represented by a graphical icon. The icons save space in the Maya interface and allow for quick 

access to tools used most often. 

In this lesson, you learn about some of the Status Line areas. 

 

 

 

 

You’ve already learned the first item on the Status line: the Menu Selector used to select between 

menu sets. 

The second group of circled icons relate to the scene and are used to create, open, and save your 

Maya scenes. 

The third and fourth group of buttons are used to control how you can select objects and components 

of objects. You will learn more about selection of objects in later lessons. 

The fifth group of icons are used to control the Snap Mode for objects and components. You will 

begin to use these tools in a later lesson in this chapter. 

The last section comprise three buttons that are used to show or hide editors, including the Attribute 

Editor, Channel Box, Layer Editor, and Tool Settings. The default display shows the Channel 

Box and the Layer Editor. When you create an object, like the cube for example, information about 

that object displays in these editors. You will learn how to use these editors later in this chapter. 

For better organization on the Status Line, all of the icon buttons are broken into groups that you can 

expand and collapse, as shown. 
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Shelf 

The Shelf is located directly below the Status line. The Maya Shelf is useful for storing tools and 

items that you use frequently or have customized for your own use. You can keep the tools and items 

you use most frequently in a location that provides handy access. Maya has some of the Shelf items 

pre-configured for your use. 

 

 

 

To create an object using a tool from the Shelf 

 

1. From the Shelf, select the Surfaces tab in order to view the tools located on that shelf. 
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2. Select Create > NURBS Primitives > Interactive Creation to ensure that a check mark does not 

appear beside the item. 

For this lesson, you won’t use this option 

3. From the Shelf, select the NURBS sphere icon located at the left end by clicking on it. 

Maya creates a sphere primitive object and places it at the center of the Maya workspace in the 

same position as the cube. 

 

TIP: 

You can determine if this is the correct tool prior to choosing it by first placing your mouse 

cursor over the icon, the name or description of it appears in a popup window directly over it. 

 

 

In your scene view the wireframe outline of the cube you created earlier in the lesson has changed 

color to navy blue, and the sphere is displayed in a bright green color. The sphere is now 

the selected object and the cube is no longer selected. In Maya, when the object displays like this, we 

refer to it as being selected or active. 
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Selection of objects and components is a way of indicating to Maya that this particular item is to be 

affected by the tool or action you will subsequently choose. As you work with Maya, you will be 

selecting and deselecting items a lot. You will learn how to select and deselect objects later in this 

chapter. 

Some numerical information appears in the Channel Box editor on the right hand side of the user 

interface. This information relates to X, Y, and Z, translation, rotation, and scaling for the active 

object. The X, Y, and Z Translate numerical values are currently set to 0. This indicates that the 

sphere’s location is at the origin. The Channel Box is useful for viewing and editing this type of 

basic information. You will use the Channel Boxlater in this chapter. 
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To hide or show the Channel Box 

1. To hide the Channel Box, click the Show/Hide Channel Box icon from the right end of the Status 

line. 

The Channel Box disappears, and the perspective scene view expands slightly. With the Channel 

Box hidden, you have more working area in your scene view. 

 

 

 

2. To show the Channel Box, click the Show/Hide Channel Box icon on the Status line. 

The Channel Box appears in the scene view. 
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Texture Artists are responsible for the creation of textures, colours and organic surface qualities 

required for computer-generated creatures and hard-surface models used in production. Texture 

Artists work closely with Modelers and Look Development Artists to create photo-real assets for 

high end visual effects films. 

3D coordinates 

The most basic visual entity is the point. The point has no size, but it has a location. 

To determine the location of points, we first establish an arbitrary point in space as the origin. 

We can then say a point’s location is so many units left (or right) of the origin, so many units up (or 
down) from the origin, and so many units higher (or lower) than the origin. 

 
These three numbers give us the 3D coordinates of the point in space. For example, a point 7 units 
right (x), 4 units down (z), and 3 units above (y) the origin has the XYZ coordinates (7,4,3). 

To specify points on the opposite side of the origin, we use negative numbers. In the example, a 
point at (-5, -2, -1) would be 5 units left of the origin, 2 units up, and 1 unit below. 

 
In computer graphics, we don’t really say the point is “left/right”, “up/down”, or “higher/lower”. 
Instead we call the three dimensions the X axis, the Z axis, and the Y axis. 

Y-up and Z-up 

In animation and visual effects, the tradition is to use Y as the “up” or elevation axis, with X and Z 
as the “ground” axes. However, some other industries traditionally use Z as the up axis and X and Y 
as the ground axes. 

In Maya, you can switch the up axis between Y and Z. 
Select Windows > Settings/Preferences > Preferences, then click Settings in the left pane. For more 
information, see Settings preferences. 
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Interface overview 

This section is a brief summary of the main Maya interface. Numbered headings below refer to the 
numbered interface elements in the figure. 

• If you can’t find the menu you’re looking for, it may be that the correct menu set is not open - 
see Menus and menu sets. You can also choose Help > Find Menu and enter the name of menu 
or command you're looking for. 

• You can show or hide elements (panels) in the main window using the Windows > UI 
Elements menu. 

• You can hide all the interface elements to maximize viewing space and instead use the quick 
command features: the hotbox, Maya Hotkeys, and Marking menus. 

• You can resize most panels by dragging their edges when a double-headed arrow cursor appears. 

• You can rearrange the panels to suit your preferences by docking them in different areas of the 
Maya window. For more information, see Dock and undock windows and panels. 

• To zoom in on the view under the mouse pointer, such as the View Panel or Graph Editor, press 
Shift + Spacebar. This collapses all other panes docked in the main window. If the mouse pointer 
is over a floating window or another part of the interface, such as the Channel Box or Tool 
Settings, it affects the last view you clicked in. Press Shift + Spacebar again to restore the 
previous viewing configuration. 

• For a full-screen view of the pane with the focus, press Ctrl + Spacebar. This works the same 
way as Shift + Spacebar for zoom-in view, but it also hides UI elements such as the Status 
Line, Shelf, Time Slider, and so on. Press Ctrl + Spacebar again to restore the previous viewing 
configuration. 

 
 

1. Menu Sets 
Menu sets divide the type of menus available into categories: Modeling, Rigging, Animation, 
FX, and Rendering. Maya's first seven menus on the main menu are always available, and the 
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remaining menus change depending on the menu set you choose. See Menus and menu 
sets for information. 

2. Menus 
The menus contain both tools and actions for working in your scene. The main menu is that 
the top of the Maya window. There are also individual menus for the panels and option 
windows. You can also access the menus in the main menu in the hotbox, which you can 
open by holding down the space bar in a view panel. See Menus and menu sets for 
information. 

3. Status Line 
The Status line contains icons for some commonly-used general commands, such 
asFile > Save, as well as icons for setting up object selection, snapping, rendering, and more. 
A quick Selection field is also available for you to set up for numeric input. Click the vertical 
dividers to expand and collapse groups of icons. 

4. User Account menu 
Log in to your Autodesk account. Click for more options, such as to manage your license or 
purchase Autodesk products. Trial versions also show many days are left. 

5. Shelf 
The Shelf contains icons for common tasks, organized by tabs based on category. The real 
power of shelves, however, is that you can create custom shelves, and then make tools or 
command shortcuts that are quickly accessed from there with a single click. See Shelves for 
information. 

6. Workspace selector 
Select a custom or predefined arrangement of windows and panels designed for different 
workflows. Shown here is the Maya Classic workspace. For more information, 
see Workspaces. 

7. Sidebar icons 
The icons at the right end of the Status line open and close tools that you will use frequently. 
From left to right, the icons display the Modeling Toolkit, the HumanIK window, 
the Attribute Editor, the Tool Settings, and the Channel Box/Layer Editor(which is open by 
default and shown here). 

In the Maya Classic workspace, these tools open as tabs in the pane below, except for 
the Tool Settings which open in a floating window. Use the tabs to switch between open 
tools, or click the current tab to collapse the whole pane. Click on any tab in a collapsed pane 
to restore it. You can also drag the tabs to change their order, or right-click on the tabs for 
more options. 

8. Channel Box 
The Channel Box lets you edit attributes and key values for selected objects. The Transform 
attributes are shown by default, but you can change which attributes are displayed here. 

9. Layer Editor 
There are two types of layers that are displayed in the Layer Editor: 
• Display Layers are used to organize and manage objects in a scene, such as for setting 

their visibility and selectability. 

• Animation Layers are used to blend, lock, or mute multiple levels of animation. 

In all cases, there is a default layer where objects are initially placed upon creation. 
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10. View panel 
The View panel offers different ways of viewing the objects in your scene with a camera 
view. You can show one or several view panels, depending on the layout you're using. You 
can also display different editors in the view panel. The Panel Toolbar in each view panel 
gives you access to many of the frequently used commands found in the Panel menus. 

11. Tool Box 
The Tool Box contains tools that you use all the time to select and transform objects in your 
scene. Use the QWERTY hotkeys to use the Select tool ( Q), Move tool ( W), Rotate tool 
( E), Scale tool ( R), and Show Manipulators ( T), as well as access the last tool used ( Y) in 
the scene. 

12. Quick layout/Outliner buttons 
The upper three Quick Layout Buttons below the Tool Box let you switch between useful 
View panel layouts with a single click, and the bottom button opens theOutliner . See Panels 
and layouts for information on how to create custom layouts. 

13. Time Slider 
The Time Slider shows you the time range that is available as defined by the range slider, 
below. The time slider also displays the current time, and the keys on selected objects or 
characters. You can drag the red playback cursor in it to "scrub" through animation, or use 
the playback controls at the right end. 

14. Range Slider 
The Range Slider lets you set the start and end time of the scene's animation. You can also 
set a playback range if you want to focus on a smaller portion of the whole animation. 

15. Playback controls 
The Playback Controls let you move around time and preview your animation as defined by 
the Time Slider range. 

16. Anim/Character menus 
The Animation or Character menus let you switch the Animation Layer and the 
currentCharacter Set. There are also icons for Auto Key and Animation preferences. 

17. Playback options 
Use the Playback options to control how your scene play backs animation, including setting 
frame rates, looping controls, and auto keying, as well as gives you quick access to the Time 
Slider preferences. 

18. Command Line 
The Command line has an area to the left for inputting single MEL commands, and an area to 
the right for feedback. Use these area if you are familiar with Maya's MEL scripting 
language. 

19. Help Line 
The Help Line gives a short description of tools and menu items as you scroll over them in 
the UI. This bar also prompts you with the steps required to use a tool or complete a 
workflow. 

 

 

Menus and menu sets 
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There are seven menus always available 
in Maya: File, Edit, Create, Select, Modify, Displayand Windows. 

All other menus change depending on the menu set you 
select: Modeling, Rigging, Animation, Dynamics, Rendering. Each menu set is designed to support a 
particular workflow. 

You select the menu set you want to work with from the drop-down list in the Status bar. 

To switch between menu sets, use the drop-down menu in the Status Line, or use hotkeys. The 
default hotkeys are: 

• F2 (Modeling) 

• F3 (Rigging) 

• F4 (Animation) 

• F5 (FX) 

• F6 ( Rendering) 

 
You can create custom menu sets that contain your choice of menu items - see Custom menu sets. 

Note: To toggle the display of the menu bar, press Ctrl+M. With no menu bar visible, you can still 
use the Hotbox to choose commands. 

Tear-off menus 

You can display menus as separate windows. This is helpful when you use a menu repeatedly. Pull 
down the menu and click the tear-off line at the top. Tear-off menus always display on top. 
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Select menu items 

You can select items from menus in different ways in Maya: 

• The main menu at the top of the Maya window - see Menus and menu sets. 

• Shelves, where the most frequently used menu items are also available as icons; for example, 
common commands from the Rigging menu set are available as icons in the Rigging shelf - 
see Shelves. 

• The hotbox - see Select actions from the hotbox 

• Marking menus - see Marking menus 

Actions and Tools 

Almost all menu items are actions, but there are also many tools. 

• When you select an action menu item, that action is performed on the selected objects or 
components. 

Some actions work differently depending on the order in which you select the objects. For 
example, you first select all the objects you want to constrain, and then select the constraining 
object last when you create a constraint. 

If the order is important, instructions about the selection order appear in the help line at the 
bottom of the Maya window. 
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• When you select a tool menu item, that tool is activated, which you can then use on objects or 
components. Instructions for using the tool appear on the help line when it's active. 

The tool stays active until you exit it by selecting another tool. 

Many items in the Curves and Surfaces menus can be converted from actions to tools (or vice versa) 
- see Switch operations between actions and tools. 

Setting Options before selecting a menu item 

For many menu items, you can set up options before executing it. When options are available, 
a  box is displayed next to the name of a menu item. See Set or reset the options for a menu 
item for more information. 

Quickly repeating the last menu item 

You can quickly repeat your last action from a menu item in Maya’s main menu, or Panelmenu with 
the middle-mouse button. For example, if your last action was to open the Windows > Animation 
Editors > Graph Editor, then middle-click the Windows menu to reopen the Graph Editor. This also 
applies to sub-menus. 

Middle-click on Panel Menus toggles radio or checkbox selections, where available. 
Note: You cannot use the middle-click repeat with Panel > Renderer menu items. 

Set or reset options for a tool or menu item 

Many tools have options, shown in the menu as a box . This option box lets you adjust and fine-
tune individual settings for each tool. 

• Click the  box next to the name of a menu item to open the action’s options window. 

• Double-click a tool to show the Tool Settings panel. 

To reset a tool or action to its original (“factory”) options 

You can return menu items to their default settings by clicking Reset. 

Do one of the following: 

• In an option window, select Edit > Reset settings. 
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• In a Tool Settings editor, click Reset Tool. 

 

 

Select Actions from the Hotbox 

The hotbox contains every action available in the Maya interface. It appears when you hold down 
the space bar in a view. 

 
The hotbox has three main functions: 

• It contains every menu and menu item. This is useful if you want to quickly use an action from 
another menu set without switching menu sets. 
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• You can use the hotbox to select actions even if you’ve hidden the menu bar (press Ctrl+M) and 
other UI elements to save space. 

• The hotbox provides five customizable marking menus you can show by clicking inside, above, 
below, left, or right of the Hotbox Controls option. 

To select an action from the hotbox 

1. Hold the space bar in a view to show the hotbox. 

The hotbox remains on screen as long as you hold the space bar. 

2. Click a menu and drag while you select an option, or click an empty area anywhere around the 
hotbox to show additional marking menus. 

Tip: Clicking the tear-off line at the top of a marking menu opens it in a separate window. 

Marking Menus 
Marking menus are used throughout the Maya interface. When you right-click an object, a marking 
menu appears that lets you select a selection mode and other actions that are in context to the type of 
object. Some marking menus appear when you hold a key and press a mouse button. 

Marking menus are very fast for experienced users because once you get used to showing them and 
the positions of their items, you can select the items using very quick gestures with the mouse or 
tablet pen, sometimes so fast the entire menu won’t even display. 

To select an item from a marking menu 

1. Do one of the following: 

• Right-click anywhere in your scene when an object is selected, and release the mouse button. 

The marking menu remains on the screen, letting you move your cursor over the item you 
want to select. 

• Right-click anywhere in your scene when an object is selected and continue holding your 
mouse button and drag in the direction of the item you want to select. It doesn't matter how far 
you drag or if you hit the item exactly. This allows you to make the drag very quickly. 
Dragging over an item with a submenu attached shows the submenu. 
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Note: You can assign marking menus to hotkeys. Hold the key and press the mouse button to show 
the marking menu. 

Polygon / NURBS marking menus 

Right-clicking a polygon or NURBS object in the scene brings up a marking menu of many 
commonly used commands. 

Menu Item Effect 

Components The upper radial section of each object type displays options to 
change the current component selection mode for that object. 

Note: Objects remain selected even when switching between 
various object and component modes. 

Shape node Allows you to display the appropriate object's shape node without 
changing the current selection. 

Select Selects the current object. 

Select All Selects all objects in the scene. 

Deselect All Clears the current selection. 

Select Hierarchy Selects the current object and anything under it in the DAG. 

Invert Selection Selects anything currently unselected in the DAG and vice versa. 

Select Similar When in component mode, Select Similar selects polygonal 
components (vertices, edges, and faces) of a similar type to the 
current selection. When in object mode, this option selects other 
objects of the same node type in the scene. 

Make Live Turns the current object into a Live surface that other objects will 
then automatically snap to. 

DG Traversal Allows you to navigate up and down the DG into the current 
object's History (upstream) and Future(downstream) without 
having to open the Node Editor. 
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Menu Item Effect 

Inputs Allows you to select and edit any / all input (upstream) 
connections to the current object's shape node. 

Outputs Allows you to select and edit any / all output (downstream) 
connections to the current object's shape node. 

Paint Provides quick access to multiple paint modes, including: Paint 
Select, 3D Paint, Sculpt Geometry, and Vertex Color painting (not 
available for NURBS curves). 

Metadata Allows you to visualize and modify metadata associated with the 
current object. 

Actions Provides quick access to Templating, (controlling the object's 
selectability), Unparenting (down to the root level), and Bounding 
Box display actions. 

UV Sets Provides quick access to options related to an object's (possibly) 
multiple UV sets (polygons only). 

Color Sets Provides quick access to options related to an object's (possibly) 
multiple color sets (polygons only). 

Scene Assembly Provides quick access to various options related to Scene 
Assembly for creating large complex scenes. 

Material Attributes Opens the current object's shader node in the Attribute Editor. 

Assign New Material Opens the Assign New Material window. 

Assign Favorite Material Allows you to assign commonly used shaders based on 
your Favorite list in the Hypershade. to the current object. 

Assign Existing Material Allows you to assign the current object any shader that already 
exists in the scene. 

Remove Material Override Removes any material overrides created on a render layer, 
reverting back to the master layer's material shader. 
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Convert Selection marking menus 

Ctrl + right-clicking an object provides a menu of selection conversion commands that mirror those 
found in the Select > Convert Selection menu as well as Contiguous Edges. The available options 
differ depending on the current object type.  

Create Polygon marking menus 

Shift + right-clicking the scene without a selection provides a menu of polygon primitives and 
creation tools. 

Polygon Tools marking menus 

Shift + right-clicking with a polygon object selected brings up a marking menu of many commonly 
used polygon tools. 

Menu Item Effect 

Target Weld Tool Activates the Target Weld Tool, which allows you to merge 
vertices or edges interactively. 

Sculpt Tool Activates the Sculpt Tool, which moves vertices in a direction 
determined by the average of all normals within the boundary of 
the tool cursor. 

Fill Holes Fills all holes in the geometry with new faces. 

Multi-Cut Activates the Multi-Cut Tool, which allows you to divide edges 
and faces by inserting new vertices / edges. 

Insert Edge Loop Activates the Insert Edge Loop, which allows you to create new 
edge loop perpendicular to the existing edges. 

Append to Polygon Tool Activates the Append to Polygon Tool, which allows you to add 
polygons to an existing mesh. 

Soften/Harden Edge Manipulates vertex normals to make all edges appear soft or hard. 

Extrude Extrudes the selected components. 

Offset Edge Loop Tool Activates the Offset Edge Loop Tool, which allows you to insert 
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Menu Item Effect 

new edge loops on either side of selected edges. 

Smooth Smooths the current mesh by adding new polygons. 

Subdiv Proxy Smooths the current mesh by adding polygons and placing it 
inside the original, non smoothed mesh, which becomes the proxy. 

Crease Tool Activates the Crease Tool, which allows you to create transitions 
between hard and soft edges. 

Project Curve on mesh Creates a new curve that is the projection of a selected curve on 
the selected mesh surface. 

Split mesh with projected curve Splits or splits and detaches edges on a polygon surface using a 
projection from the selected curve. 

Mirror Provides the options found in the Mesh > Mirror menu, to mirror 
the selected mesh across an axis. 

Mapping Provides options to apply a default UV map to the selected faces. 

Triangulate Faces Converts the selected faces to triangles to ensure proper rendering. 

Quadrangulate Faces Converts the selected faces to quads to ensure proper rendering. 

Separate Separates the selected polygon into the individual polygon shells 
(if any exist) that make it up. 

Combine Combines the selected polygon shells into a single object. 

Booleans Provides the options found in the Mesh > Booleansmenu, to model 
based on the intersection points of two meshes. 

Reduce Retopologizes the selected object in an attempt to reduce the 
overall number of polygons. 

Cleanup Opens the Cleanup Options , which allow you to remove 
unwanted geometry or tesselate faces that may be valid in Maya 
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Menu Item Effect 

but not elsewhere. 

Connect Tool Activates the Connect Tool allowing you to connect components 
by inserting edges between them. 

Quad Draw Tool Activates the Quad Draw Tool, which allows you to draw new 
polygons by placing dots in the scene. 

Polygon Display Allows you to toggle various display settings based on the 
component type currently selected. 

UV marking menus 

Shift + right-clicking a polygon object while in UV selection mode brings up a marking menu of 
many commonly used UV tools. 

Menu Item Effect 

Mapping Allows you to project new UVs onto the mesh. 

3D Cut and Sew UV Tool Allows you to create or merge UV shell seams directly in the 
viewport. 

3D Grab UV Tool Allows you to drag UVs directly in the viewport. 

Cut UVs Separates the selected UV edges. 

Sew UVs Attaches the selected UV edges. 

Delete UVs Removes the selected UVs. 

Create UV Shell Creates a UV shell(s) out of each set of adjacent selected UVs. 

Merge UVs Merges the selected UVs (assuming they belong to the same UV 
shell). 

Auto Seams Automatically cuts seams into the shell pertaining to the selected 
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Menu Item Effect 

UVs. 

Texture Borders Displays texture borders in the viewport. 

UV Editor Opens the 2D UV Editor. 

UV Set Editor Opens the UV Set Editor. 

UV Shell marking menus 

Shift + right-clicking a polygon object while in UV Shell selection mode brings up a marking menu 
of many commonly used UV shell tools. 

Menu Item Effect 

Mapping Allows you to project new UVs onto the mesh. 

3D Cut and Sew UV Tool Allows you to create or merge UV shell seams directly in the 
viewport. 

3D Grab UV Tool Allows you to drag UVs directly in the viewport. 

Unfold Unfolds the object's UV shell. 

Optimize Evens out the space between UVs. 

Layout Spreads out an object's UV shells to make the best use of 0-1 UV 
space. 

Flip Changes the orientation of the UV shell. Useful if a texture 
appears backwards. 

Auto Seams Automatically assigns / cuts seams into the UV shell. 

Texture Borders Displays texture borders in the viewport. 

UV Editor Opens the 2D UV Editor. 
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Menu Item Effect 

UV Set Editor Opens the UV Set Editor. 

NURBS curves marking menus 

Shift + right-clicking a NURBS curve brings up a marking menu of many commonly used NURBS 
commands. 

Menu Item Effect 

Add Points Tool Activates the Add Points Tool, which allows you to extend certain 
types of curves (such as CV, EP, and Pencil)q. 

Open / Close Curves Separates or connects the first and last points of the selected 
curves. 

Reverse Curve Reverses the curve direction by renumbering the points. 

Convert NURBS to Bezier Converts the selected NURBS curve to a Bezier curve.  

Bezier Curve Tool Activates the Bezier Curve Tool, allowing you to modify or 
extend the selected Bezier curve. 

Transform marking menus 

Ctrl + Shift + right-clicking your scene when different transformation tools are active, or holding the 
shortcut key for that tool and left-clicking the scene, opens a marking menu full of various settings 
related to that particular transformation tool. 

Common Transform marking menus 
The following marking menus are common to the Select Tool, Move Tool, Rotate Tool, and Scale 
Tool. 

Menu Item Effect 

Selection Constraints Lets you select components based on a specific type of constraint 
(i.e. edge loops only or border edges only). 
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Menu Item Effect 

Transform Constraints Lets you select a transform constraint. 

Smart Duplicate Lets you Shift + drag to create duplicates. 

Smart Extrude Lets you shift + drag to extrude components. 

Preserve UVs Maya automatically transforms UVs in the UV space relative to 
the transformations taking place in the scene view (not available 
for Select Tool). 

Preserve Children Maintains the position of child objects when you move a parent 
object (not available for Select Tool). 

Tweak Mode Turns Tweak Mode on and off (not available for Select Tool). 

Symmetry 

Menu Item Effect 

Symmetry Turns Object symmetry on. 

Topology q/ World / Object Sets the symmetry space. 

X Axis / Y Axis / Z Axis Lets you choose whether to reflect your selection along the X-axis, 
Y-axis or Z-axis. 

Select 

Menu Item Effect 

Marquee Turns Marquee select on and off. 

Pre-selection Highlight Turns Preselection Highlight on and off. 

Highlight Nearest Component When enabled and Maya is in component mode, automatically 
highlights the component (according to the active component 
selection setting) closest to the mouse cursor for selection. 
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Menu Item Effect 

Highlight Backfaces When enabled, backfacing components are highlighted for 
preselection and are selectable. When this option is disabled, 
backfacing components are still selectable, but they are not 
highlighted for preselection. 

Asset Centric Turns Asset Centric selection on and off. 

Soft Select Opens the Soft Select marking menu. 

Camera Based Selection Turns on Camera Based Selection. 

Clear Selection Deselects all selected components. 

Soft Select 

Menu Item Effect 

Soft Select Turns Soft Selection on and off. 

Object / Global / Surface /Volume Sets the Falloff Mode for Soft Selection. 

Color Feedback Turns color feedback for Soft Selection on and off. 

Select Tool marking menus 
The following marking menus give you access to options associated with the Select Tool. You can 
also access these marking menus by holding Q + clicking in your scene. 

Menu Item Effect 

Paint Select Changes the selection mode to Paint Select. 

Lasso Changes the selection mode to Lasso Select. 

Move Tool marking menus 
Holding W + clicking in your scene opens a marking menu of options associated with the Move 
Tool. Most of the options can also be found in the Move Tool Settings. 
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Menu Item Effect 

Axis / World / Object / Component Sets the Move Axis (coordinate system) for the Move Tool. 

Keep Spacing Maintains relative spacing when snap settings are on. 

Update Triad Determines whether the manipulator is updated during 
manipulation or when the mouse button is released, when 
moving components along their normals. 

Move Options Opens the Tool Settings. 

Axis 

Menu Item Effect 

Live Object 
Axis / Normal / Parent / Along 
Rotation Axis 

Sets the Axis Orientation for the Move Tool. 

Custom Sets the Axis Orientation to a Custom axis orientation based on a 
specified point, edge, or face. 

Snap 

Menu Item Effect 

Discrete Move Lets you move components by specified increments. 

You can modify the increments in the Tool Settingseditor. 

Face Center / Vertex Lets you move and snap to a live polygon’s components. 

Both can be turned on simultaneously. 

Relative Mode Lets you move components relative to their initial orientation or 
scale. 

Rotate Tool marking menus 
Holding E + clicking in your scene opens a marking menu of options associated with the Rotate 
Tool. Most of the options can also be found in the Rotate Tool Settings. 
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Menu Item Effect 

Object / World/Component /Gimbal / Custom Sets the Axis Orientation for the Rotate Tool. 

Custom Sets the Axis Orientation to a Custom axis orientation 
based on a specified point, edge, or face. 

Rotate Object Center Lets you rotate object components around the 
object’s pivot point. 

Free Rotate When on, dragging the area inside the rotation 
manipulators (the center) rotates the object or 
component. 

When off, you can only rotate the object or 
component by dragging the rotation manipulators. 

Relative Lets you rotate or scale components relative to their 
initial orientation or scale. 

Rotate Options Opens the Tool Settings. 

Scale Tool marking menus 
Holding R + clicking in your scene opens a marking menu of options associated with the Scale Tool. 
Most of the options can also be found in the Scale Tool Settings. 

Menu Item Effect 

Axis / World /Object/Component Sets the Axis Orientation for the Scale Tool. 

Snap Scale Lets you scale components by specified increments. 

You can modify the increments in the Tool Settingseditor. 

Relative Lets you rotate or scale components relative to their initial 
orientation or scale. 

Scale Object Center Lets you scale object components around the object’s pivot point. 

Prevent Negative Scale Stops all single axis scaling operations on components at 0. 
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Menu Item Effect 

Scale Tool Settings Opens the Tool Settings. 

Axis 

Menu Item Effect 

Live Object 
Axis / Normal / Parent / Along 
Rotation Axis 

Sets the Axis Orientation for the Scale Tool. 

Custom Sets the Axis Orientation to a Custom axis orientation based on a 
specified point, edge, or face. 

Input / Output marking menus 

Holding A + clicking in your scene opens a marking menu of options related to incoming and 
outgoing connections to the currently selected objects. 

Menu Item Effect 

Enable All Outputs / Disable All 
Outputs 

Enables / Disables all outgoing values from the selected node. 

Delete History / Delete Non-
Deformer History 

Clears the appropriate type of construction history. 

Select All Inputs / Select All 
Outputs 

Selects incoming / outgoing connections to the selected node. 

Freeze Transformations Resets the selected object's current transformations to zero. 

Component Marking Menus 

Shift + right-clicking your scene when in component selection mode opens a marking menu specific 
to the type of component (vertices, edges, or faces) currently being selected. 

Common Component marking menus 
The following marking menus are common to the Vertex, Edge, and Face component modes. 
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Menu Item Effect 

Merge Provides options for merging multiple selections of the same 
component into one. 

Paint Select Activates Paint Selection mode for the current component type. 

Multi Cut Activates the Multi-Cut Tool, which allows you to divide edges 
and faces by inserting new vertices / edges. 

Delete Deletes the selected component (vertices and edges only). 

Normals Presents a number of options to modify the selected components 
normals (vertices and faces only). 

Extrude Extrudes the selected components. 

Crease Tool Activates the Crease Tool, which allows you to create transitions 
between hard and soft edges (vertices and edges only). 

Connect Components Connects the selected vertices, edges, or faces (in the form of their 
border edges) to the last selected vertex or edge. 

Detach Components Separates components into multiple overlapping components. 

Transform Component Activates a Manipulator Tool based on the last selected 
component. 

Connect Tool Activates the Connect Tool allowing you to connect components 
by inserting edges between them. 

Polygon Display Allows you to toggle various display settings based on the 
component type currently selected. 

Vertex marking menus 
Shift + right-clicking the scene in Vertex component mode opens a marking menu of vertex tools 
and options. 

Menu Item Effect 
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Menu Item Effect 

Average Vertices Averages the distance between the selected vertices. 

Chamfer Vertex Chamfers the selected vertices. 

Apply Color Assigns color data to the selected vertices. 

Edge marking menus 
Shift + right-clicking the scene in Edge component mode opens a marking menu of edge tools and 
options. 

Menu Item Effect 

Flip/Spin Edge Flips or spins edges to opposite corners of a face. 

Bevel Edge Expands the selected edge into a new face based on the 
current Bevel Options. 

Soften/Harden Edge Manipulates vertex normals to make connected edges appear soft 
or hard. 

Offset Edge Loop Tool Activates the Offset Edge Loop Tool, which allows you to insert 
new edge loops on either side of selected edges. 

Insert Edge Loop Activates the Insert Edge Loop, which allows you to create new 
edge loop perpendicular to the existing edges. 

Slide Edge Tool Lets you reposition a selection of edges or entire edge loops on a 
polygon mesh. 

Edit Edge Flow Adjusts the position of the selected edges to fit the curvature of the 
surrounding mesh. 

Add Divisions To Edge Allows you to split an edge using multiple vertices. 

Bridge Creates faces connecting the selected border edges. 

Fill Hole Automatically creates a three or more sided face to fill an open 
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Menu Item Effect 

area bordered by the selected edge. 

Face marking menus 
Shift + right-clicking the scene in Face component mode opens a marking menu of face tools and 
options. 

Menu Item Effect 

Poke Face Creates a vertex at the center of the selected face(s) and adds 
vertices to properly triangulate them. 

Bevel Face Expands the selected face's edges into a new faces based on the 
current Bevel Options. 

Wedge Face Extrudes an arc out of the selected face until it is within a 
certain Arc angle of the selected edge. 

Smooth Faces Adds new polygons to smooth out vertices and edges bordering 
the selected faces. 

Assign Invisible Faces Removes all shading from the selected faces (but does not remove 
the face itself). 

Add Divisions To Faces Subdivides selected faces into additional faces. 

Triangulate Faces Converts the selected faces to triangles to ensure proper rendering. 

Quadrangulate Faces Converts the selected faces to quads to ensure proper rendering. 

Reduce Faces Retopologizes the selected faces in an attempt to reduce the 
overall number of polygons. 

Bridge Faces Creates faces connected the selected faces' opposite border edges. 

Extract Faces Disconnects the selected faces from the mesh. 

Duplicate Face Creates a copy of the selected faces. 
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Menu Item Effect 

Target Weld Activates the Target Weld Tool, which allows you to merge 
vertices or edges interactively. 

Mapping Provides options to apply a default UV map to the selected faces. 

 

 
 
Texturing artist: Roles and Responsibilities 
Texturing artist in the Media & Entertainment Industry is also known as a Shading artist  
 

Brief Job Description  

Individuals at this job are responsible to add textures to models to create photo-realistic models that 

can be used for animation 

Responsibilities: 

• Collaborate with the CG Supervisor and Lead Texture Artist to execute the required look of 

CG characters and objects 

• Continual and efficient communication with the Look Dev and Modelling departments 

• Quality control of texture maps prior to publishing to ensure consistency 

• Meeting schedules and set deadlines while maintaining the highest standards 

• Communicating with Production and Leads regarding schedules and deadlines 

• Sharing techniques, reference material and ideas with the team 

• Continuing to become familiar with new tools, software, data and other related technology 

Essential Skills: 

• The ability to work within a team of other Texture Artists or independently 

• A commitment to creative collaboration within the team and with other departments 

• Proactive and excellent communication, organisation and interpersonal skills 

• Creative problem solving skills 



39 
 

• The proven ability to work well under pressure 

• Open to direction and able to embrace change 

• Attention to detail 

• Reliable with good time keeping and the ability to meet set deadlines 
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Unit 2: Shading and Texturing 

Surface shading 

  

In the real world, what an object is made of is one of two main factors that determine the appearance 
of its surface (the other is light). This is because when light hits the objects, some of the light is 
absorbed and some of it is reflected. The smoother the object, the shinier it is; the rougher the object, 
the more matte it is. 

In Autodesk®Maya®, the appearance of a surface is defined by how it’s shaded. Surface shading is a 
combination of the basic material of an object and any textures that are applied to it. 

In Maya, materials (also called shaders) define an object’s substance. Some of the most basic 
attributes of materials include color, transparency, and shine. For more information on materials in 
Maya, see Surface, displacement, volumetric materials . 

Factors beyond basic color, transparency, and shine that determine the appearance of an object’s 
surface (such as more complex color, transparency, shine, surface relief, reflection, or atmosphere) 
are defined by textures. For more information on textures, see 2D and 3D textures, Procedural 
textures, and File textures. 
 

About backgrounds 

Typically you render the objects in a scene against a black background and composite the rendered 
images later with an appropriate background using compositing software. However, you can insert a 
background: 

• to avoid having to model background objects or scenery, but want them represented, 2Dly, in 
your scene (especially if you don’t have access to compositing software). 
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• as a temporary reference (especially for rotoscoping or motion matching) for modeling or 
animating objects in the scene. 

 

Basic color and texture backgrounds 

 

Color backgrounds 

A color background floods the background of the scene with a solid color (for example, black, white, 
or red).  

 
Create a basic color background 

To create a color background 

1. In the Environment section of the camera’s Attribute Editor (View > Camera Attribute 
Editor), set the Background Color attribute. 

For more information on a camera’s Attribute Editor, see Attribute Editor in the Basics guide. 
 

Texture backgrounds 

A texture background uses a 2D, 3D, or environment texture on an image plane to simulate a 3D 
background, or environment. 

 
Create a texture background 

 To create a texture background 

1. In the Environment section of the camera’s Attribute Editor (View > Camera Attribute 
Editor), click the Create button to the right of the Image Plane attribute. 

Maya creates an image plane and connects it to the camera. 
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2. Set the Type attribute for the image plane to Texture. 

3. Click the texture button for the Texture attribute. 

The Create Render Node window appears. 

4. Select the texture you want to use as a background (for example, an Environment Texture). 

Maya creates the texture and connects it to the image plane. 
 

Create, edit, or position an image plane 

To create an image plane 

1. Select View > Image Plane > Import Image from the current view. 

2. Browse to the file you want and click Open. 

A placement icon appears in either the current view or all views, depending on the Display mode 
you set (in all views by default), and the Image Plane Attribute Editor opens. 

3. Select an Image File or Texture from the Type drop-down list, then click the folder icon next 
to Image Name to load an image plane into the view. 

 

For a description of image plane attributes, see Image plane 

To edit an existing image plane 
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1. Select View > Image Plane > Image Plane Attributes from the current view and choose any of 
the camera’s image planes you want to edit. 

The selected image plane’s attributes display in the Attribute Editor (unless the Attribute 
Editor has been hidden) 

 

Tip 

Right-click the arrow key of the image plane attribute in the camera to display a list of the image 
planes per camera. 

To position an image plane 

1. Do one of the following: 

• Use the Placement attributes to position an image plane relative to the camera.  

• Use the Placement Extras attributes to control which portion of an image file is visible on the 
image plane.  

 

Apply color and shading to an object 

After you have created your model, you can add color and shading to it by doing the following: 

• Create a material and assign it to your object 

• Set a color for the object 

• Map a texture to any of the material attributes 

• Adjust the material attributes; for example, its specularity, transparency, and so forth 

Create a material and assign it to your object 

Right-click your object in the viewport and select Assign New Material. Select any of the available 
shaders from the editor that appears. In this example, a Phong shader is created and assigned to the 
body of the dinosaur model. 

Set a color for the object 

You can set a color for your object by clicking the Color value swatch to edit the color using 
the Color Chooser. 

Alternatively, you can map a texture to the Color attribute of your material, as demonstrated in 
the Map a texture to any of the material attributes section below. 

Map a texture to any of the material attributes 
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You can map a texture to any of the material attributes that appear with a  icon beside it. 

For example, you can add color to your model by mapping a file texture to the 
material's Color attribute, or add surface detail by mapping a normal map to the Bump 
Mappingattribute to give the appearance of a rough surface. 

1. Click the  icon beside the Color attribute and select File. 

A File texture node is created. Click the browse icon beside Image Name to navigate to your 
texture file. 

Press 6 for textured mode in the viewport to see the texture applied to the dinosaur. 

2. Similarly, click the  icon beside the Bump Mapping attribute and select File. 

Select the file node in the Attribute Editor and click the browse icon to navigate to your normal 
map. 

3. Display your normal map in tangent space or object space. 

In this example, the bump on the model's body is not very realistic. To correct this, select the 
bump2d node, then select Use As > Tangent Space Normals. 

Note: A  icon indicates that a texture has been mapped to an attribute. 

Adjust the material attributes 

You can further refine the shading of your model by adjusting any other material attribute. 

For example: 

• Increase the size of the specular highlights by adjusting the Cosine Power attribute 

• Give the dinosaur a metallic, shiny skin by changing the Specular Color to a lighter grey 

The attributes that you can adjust depend on the shader that you have assigned to the material. 
Different attributes are available for the Blinn shader, for example, as compared to the Lambert 
shader. 

Create layered shaders 

You can layer shaders when you want to use more than one material for an object. Layered shaders 
let you create the appearance of variations in the material qualities of the surface by combining two 
or more material nodes that each have their own qualities. Layered shaders render more slowly than 
other materials, so consider using Layered textures instead to achieve similar results. 
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Layered textures with the Layered Shader node 

The Layered Shader node has an attribute called compositing flag that causes the shader type to layer 
materials or layer textures. You can use this to layer textures with the Layered Shader node. 
However, using the Layered Texture node is recommended because you can set many more options. 
See Layered textures for more information. 

If you choose the texture option for the compositing flag, you must plug the whole network into a 
material (for example, Phong or Blinn). 

For a description of this flag and other attributes of the node, see the Layered Shader node reference. 

To create a layered shader (example) 

1. Create a Layered Shader in the Hypershade. 

2. Select the Layered Shader node and open the Attribute Editor. 

3. Create a Lambert shader and drag to the area with the green swatch in the Attribute Editor. 

4. Create a Phong and do the same. 

The leftmost shader is the topmost material. You’ll have to have some level of transparency to see 
the shader underneath. So, for this example, you’ll need to map the Lambert’s transparency channel 
with something to see the shiny Phong underneath. Then assign the shader to an object. 

Textures 

In visual arts, a texture is any kind of surface detail, both visual and tactile. In Maya, you create 
surface detail with textures connected to the material of objects as texture maps. Materials define the 
basic substance of an object, and textures add detail. 

You can connect textures to almost any attribute of a material; the most common ones being color, 
transparency and shine (specularity). For more information on material attributes, see Common 
surface material attributes and Common surface material Specular Shading attributes.  

 In addition, you can also add detail to the appearance of an object’s surface by adding Surface relief. 
Do this by connecting textures as bump maps or displacement maps.  

A set of 2D and 3D textures are provided in Maya. In addition, you can create a Filetexture and 
connect to it your own image file. 

2D and 3D textures 

Texture nodes are one type of render node that, when mapped to the material of an object, let you 
define how the surface of an object looks when rendered. 

Texture node(s) (with material nodes) feed into the Shading Group node, which tells the renderer 
how to shade the surface.  
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Texture nodes are procedural textures generated by Maya or bitmap images imported into Maya that 
you can use as texture maps for material attributes. Texture maps on various attributes such as color, 
bump, and specularity affect the appearance of the material. For more information about texture 
maps,  

2D textures 

2D textures wrap around an object, like gift wrapping, or stick to a flat surface, like wallpaper. 

3D textures 

3D textures project through objects, like veins in marble or wood. 

With a 3D texture, objects appear to be carved out of a substance, such as rock or wood. You can 
scale, rotate and move 3D textures interactively in a scene view to achieve the desired results. 

Environment textures 

Environment textures are commonly used either as backgrounds for objects in your scene or as 
reflection maps. 

Layered textures 

There are two ways to layer textures in Maya: using the Layered Shader with the texture 
compositing flag, or with the Layered Texture Node. 

Though the workflow for using the Layered Texture node is similar to the Layered Shader, using 
the Layered Texture node is recommended because you can set many blend modes. 

Overview of texture nodes 
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Shared 2D texture attributes 

For texture-specific attributes, see the 2D texture name: Bulge, Checker, Cloth, File, Fluid Texture 
2D, Fractal, Grid, Mountain, Movie,Noise, Ocean, Ramp, Water. 

Color Balance 

Corrects the color or intensity of a texture. 

Exposure 

Adjusts the brightness of the image. The modified colors are used for rendering, as well as 
for display in Viewport 2.0. 

Note: Exposure is available only for File texture nodes. 

Default Color 

If you map a texture to a material in such a way that it that does not cover the entire surface, 
the file node’s Default Color shows through. To select a different color, click the color bar to 
open the Color Chooser. To change the texture’s coverage, use the placement options. 

Color Gain 

Scaling factor applied to the texture’s outColor channel. For example, you can color-correct a 
texture that appears too green by setting the Color Gain to a shade of blue. The default color 
is white (no effect). 

Color Offset 

Offset factor applied to the texture’s outColor channel. For example, you can brighten a 
texture that appears too dark by setting the Color Offset to a shade of gray. The default color 
is black (no effect). 

Alpha Gain 

Only has an effect if the texture is used as a bump or displacement. Scaling factor applied to 
the texture’s outAlpha channel. The default value is 1 (no effect). 

Alpha Offset 

Only has an effect if the texture is used as a bump or displacement. Offset factor applied to 
the texture’s outAlpha channel. For example, if the Alpha Gain value is -1 and the Alpha 
Offset value is 1, the outAlpha channel is inverted. The default value is 0 (no effect). 

Alpha Is Luminance 
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Off by default. The alpha (mask) output depends on the luminance of the color channels. 
Bright areas of the texture are more opaque when compositing, and dark areas are more 
transparent. 

Note: 

You cannot use Alpha Is Luminance for Cloth, Ramp, or Stencil textures. 

Shared 3D texture attributes 

Color Balance 

Corrects the color or intensity of a texture. 

Default Color 

If you map a texture to a material in such a way that it that does not cover the entire surface, 
the file node’s Default Color shows through. To select a different color, click the color bar to 
open the Color Chooser. To change the texture’s coverage, use the placement options. 

Color Gain 

Scaling factor applied to the texture’s outColor channel. For example, you can color-correct a 
texture that appears too green by setting the Color Gain to a shade of blue.The default color 
is white (no effect). 

Color Offset 

Offset factor applied to the texture’s out Color channel. For example, you can brighten a 
texture that appears too dark by setting the Color Offset to a shade of grey. The default color 
is black (no effect). 

Alpha Gain 

Only has an effect if the texture is used as a bump or displacement. Scaling factor applied to 
the texture’s out Alpha channel. The default value is 1 (no effect). 

Alpha Offset 

Only has an effect if the texture is used as a bump or displacement. Offset factor applied to 
the texture’s out Alpha channel. For example, if the Alpha Gain value is -1 and the Alpha 
Offset value is 1, the out Alpha channel is inverted. The default value is 0 (no effect). 

Alpha Is Luminance 

Off by default. The alpha (mask) output depends on the luminance of the color channels. 
Bright areas of the texture are more opaque when compositing, and dark areas are more 
transparent. 
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Note: 

You cannot use Alpha Is Luminance for Cloth, Ramp, or Stencil textures. 

Effects 
Filter 

Filter attributes scale the size of the filter and let you specify the amount of blur in the texture 
map. Use it as an anti-aliasing technique used to refine file textures, reduce flickering, or to 
achieve special effects. 

By default, Filter is set to a value of 1.0 to help prevent such aliasing effects. The effect 
of Filter is related directly to eye space. As the object moves further away from the eye, the 
more the texture blurs. 

Filter Offset 

Controls the texture blur in texture space (not eye space). Use Filter Offset for a blurred 
effect instead of anti-aliasing. Maya adds a constant value to the Filter setting. The default 
value is 0. Increasing the value increases the texture blur. For example, 1.00 completely blurs 
the texture. 

Tip: 

A Filter and Filter Offset of 0.00 results in no blur effect, but a small amount of blur can help 
reduce moiré and aliasing effects in texture maps. 

Invert 

Reverses all texture colors (black becomes white, white becomes black, and so on). Invert is 
off by default. For example, you can change a bump or displacement map’s raised regions to 
depressions and vice versa by setting Invert on or off. 

 

Local, Wrap 

Wrap repeats or tiles the texture completely over the object. If off, everything outside the 3D 
placement cube displays the texture’s default color. Wrap is on by default. 

Tip: 
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Some nodes, such as the Reverse utility, repeat themselves to achieve the effect of Wrap, so 
that it extends infinitely. Others, such as a Marble texture, extend outwards without 
repeating. 

To adjust texture placement on all objects at once, turn Local on, transform the texture 
placement icon, then turn Local off to see the results. Turning on Local also means that if 
you transform any of the objects during an animation, the 3D texture transforms accordingly. 

Blend 

Controls how much of the texture’s Default Color is mixed into the texture Color. A value of 
0 means the Default Color does not affect the texture Color. As you increase the Blend value, 
more and more of the Default Color mixes in. This attribute does not work unless Wrap is 
turned off and Local is turned on. 

To blend colors and textures using the Blend slider 

1. Change the Default Color (in the Color Balance section of the texture’s Attribute 
Editor), or map another texture to the Default Color. 

2. Make sure Invert and Wrap are off and turn Local on. 

3. Drag the slider to change the Blend value. 

Color Remap 

Applies a color map to the texture and lets you add or subtract colors from a texture’s default 
settings. Maya maps the U value to the original texture’s hue, and the V value to the original 
texture’s intensity.  

To remap a texture 

1. Click the Insert button under the Color Remap section. The texture colors change 
and a Remap Ramp Attribute Editor appears. Adjust the Ramp texture colors and 
attributes if necessary. 

 

 

 

UVs 

UVs (pronounced U-VEEZ) are two-dimensional texture coordinates that reside with the vertex 
component information for polygonal and subdivision surface meshes. 

UVs exist to define a two-dimensional texture coordinate system, called UV texture space. UV 
texture space uses the letters U and V to indicate the axes in 2D. UV texture space facilitates the 
placement of image texture maps on a 3D surface. 
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UVs are essential in that they provide the connection between the surface mesh and how the image 
texture gets mapped onto the surface mesh. That is, UVs act as marker points that control which 
points (pixels) on the texture map correspond to which points (vertices) on the mesh. Textures 
applied to polygon or subdivision surfaces that do not possess UV texture coordinates will not 
render. 

Although Maya creates UVs by default for many primitive types, you’ll need to rearrange the UVs 
in most cases, because the default arrangement will usually not match any subsequent edits to the 
model you may make. In addition, the location of the UV texture coordinates do not automatically 
update when you edit a surface mesh. 

In most cases, you map and arrange UVs after you have completed your modeling, but before you 
assign textures to the model. Otherwise, changing the model will create a mismatch between the 
model and the UVs, and affect how any textures appear on the model. 

Understanding the concept of UVs and how to map them to a surface, and subsequently lay them out 
accurately is essential for producing textures on polygonal and subdivision surfaces when working in 
Maya. This is also important when you need to paint textures, fur, or hair onto a 3D model. 

Note: For NURBS surface types the texture coordinates (UVs) that control the placement of a 
texture exist by default and are implicitly connected to the control vertices. When the control 
vertices get repositioned, so do the positions of the corresponding UV texture coordinates. Any 
textures mapped to the surface will adjust automatically. 

Texture mapping 
To apply a texture to an object, you map the texture to an attribute on the object's material. (Textures 
and materials are render nodes. The attributes to which the texture is connected determines how the 
texture is used and how it affects the final results. 

Maya has a number of textures that you can map onto objects. For example, if you connect Maya’s 
2D black and white Checker texture to the color attribute of an object’s material, you have applied a 
color map; the checkered pattern determines which parts of the object appear black and which 
appear white (or other colors if you adjust the texture’s color attributes). 
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If you connect the black and white Checker texture to the transparency attribute, you have applied a 
transparency map; the checkered pattern determines which parts of the object are opaque and which 
are transparent. 

 

Commonly used texture maps 

To map a texture, see Map 2D or 3D texture. 

Color maps 
By mapping a texture to the Color attribute of an object’s material, you create a color map which 
describes the color of the object. 

To learn more about how you can work with color, see Common surface material attributes. 

Transparency maps 
By mapping a texture to the Transparency attribute of an object’s material, you create a transparency 
map which lets you make parts of an object opaque, semi-transparent, or entirely transparent. 

To learn more about how you can work with transparency, see Common surface material attributes. 

Specular maps 
By mapping a texture to the Specular attribute of an object’s material, you create a specular map 
which lets you describe how shine appears on objects (by controlling highlight). 

To learn more about how you can work with highlight, see Common surface material Specular 
Shading attributes. 

Reflection maps 
By mapping a texture to the Reflected Color attribute of an object’s material, you create a reflection 
map which lets you describe how an object reflects its surroundings. 

Bump maps 
By mapping a texture to the Bump attribute of an object’s material, you create a bump map which 
lets you add the illusion of surface bump detail to a surface. 
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Displacement maps 
Displacement maps let you add true dimension to a surface at render time, a process which may 
reduce or eliminate the need for you to create complex models. 

UV mapping 

The process of creating explicit UVs for a surface mesh is called UV mapping. UV mapping is a 
process whereby you create, edit, and otherwise arrange the UVs (that appear as a flattened, two-
dimensional representation of the surface mesh, over top of the two-dimensional image to be used as 
a texture as it appears in the UV Texture Editor. 

 
The UV mapping process results in a correlation between the image and how it appears as a texture 
when mapped onto the three-dimensional surface mesh. UV mapping is a critical skill to master for 
accurate and realistic textures on polygonal surfaces. 

• You create UVs by mapping them onto your surface mesh. For more information see Mapping 
UVs. 

• You view and edit UVs using the UV Texture Editor. You can display the texture image as a 
background image to let you more easily correlate the UVs to the texture. 

• You use the tools in the UV Texture Editor to lay out and manipulate the 2D representation of 
UVs. For more information see Editing UVs. 

 

Creating UVs 

In Maya, UV texture coordinates (UVs) can be created for polygon surface meshes using the 
following UV mapping techniques: 

• Automatic UV mapping 
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• Planar UV mapping 

• Cylindrical UV mapping 

• Spherical UV mapping 

• User-defined UV mapping 

• Best Plane mapping 

• Camera UV mapping - see Planar UV mapping 

Each UV mapping technique produces UV texture coordinates for the surface mesh by projecting 
them onto the surface mesh based on its inherent projection method. However, the initial mapping 
produced via the above UV mapping techniques does not usually produce the final UV arrangement 
that is required for a texture. As a result, you will often need to perform further editing operations on 
the UVs using the UV Editor. It is best to map UVs onto a model only when it is complete. 

Note: Polygon and subdivision surface primitives have default UV texture coordinates that can be 
used for texture mapping. However, if you modify the default primitives in any way (that is, scale, 
extrude faces, insert or delete edges) you will need to map a new set of UV texture coordinates onto 
the object to suit your texture mapping requirements. 

Bump maps 

Bump maps are grayscale textures you map to objects to create the illusion of surface relief 
(elevations and depressions) on an otherwise flat object. 

With bump maps, depressions and elevations look real because they don’t alter the geometry of the 
surface the way Displacement maps do. Bump maps just change the direction of the surface’s 
normals based on the bump map’s Alpha Gain value. 

Use bump maps to create very shallow reliefs. For example, you can make objects look like they are 
embossed, have shallow rolling hills, and so on. 

Because bump maps are not true surface relief, they: 

• cannot cast or receive shadows 

• cannot be seen if you silhouette the mapped object 

• take less time to render than displacement maps 

Note: File textures that are used for bump mapping are usually connected via their out 
Alpha attribute. If the corresponding texture image file does not provide an alpha channel, then 
the bump effect may be missing when using certain image formats. 

To avoid this, turn on the Alpha is Luminance attribute in the Color Balance section of the File 
Texture node. For more information, see File. 

Tip: 



55 
 

• Map surface relief (bumps or displacements) to the Blinn surface material to reduce highlight 
roping or flickering. The soft highlights on Blinn surfaces are less likely to cause roping or 
flickering than the harder highlights on Phong surfaces. 

• Although scratches are like little depressions, you can more easily achieve them with 2D 
textures. 

Simple specular map made in Photoshop 

Just like the bump map you can quickly make specular map in PS by changing a few parameters.  

a.) Desaturation 
To do this simply select Hue/Saturation(Ctrl+U)and set the value of Saturation to -100 or slightly 
less. 

 

b.) Inversion 
Unfortunately now all of the reflections would be in the hollows but we want to achieve just the 
opposite of that. That’s way you need to do inversion. Key combination Ctrl + i will do color 
inversions and already we can see that map is close to what you are expecting. 

 

c.)Levels 
You have to set the Levels that so the black areas will be really crisp and so are going to see the 
transitions between black and white points. 
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d.) Sharpen  
It’s always worth to make our map a little sharper. Just go to Filter-> Sharpen-> Smart Sharpen and 
play with the sliders. Immediately you have a real-time view in the window how the sharpening is 
changing. Of course you cannot overdo with this. 

 

And this is how it looks like step by step. 

 

2.Crazy bump 

Here is very simple work to do. We will do everything in analogy of the creating the bump map. 
a.) Import a map 
Now, you have to open your map. Select that option which you can see on the left in the picture 
below. Once have you chosen the map wait until Crazy Bump will stop thinking and then new 
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window will appear like on the right side in the picture. What’s going on? If you remember how the 
bump map works(you have to know it!), you should immediately guess that the program gives us a 
choice of what type of map we want. Map on the left has darker places so when you will choose that 
one , your map will give more concavity effect, and the map on the right is the inverse. In fact it 
doesn’t make a big difference which type you will choose, because in 3ds max you can set the right 
value of the map. 

 

b.)Settings 
First of all there is a fewer setup sliders than on bump card however that doesn’t change the fact that 
you can get great effect or screw up everything :D 

Description of the parameters for the Specularity map 

Slope influence 

 - here you can make that the holes will look deepen. I don’t recommend changing it from a zero 
value. Below you can view how map is changing while you are changing this and the other settings. 

 Texture influence 

- Here you can change the influence of texture on the map. Why I would to change it from a zero 
value? It’s a very good question :P It’s only useful when you have a texture with a lot of pits and 
bulges, then you can make that the light will reflect only on the most sharp places. 

Enhence detail 

- responsible for the amount of detail to be included on the map. 

 Brightness 

- higher value makes map will be… all shiny without taking into account the number of pits and 
bulger of diffuse map.  

 Contrast 
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- with increasing contrast, collapse places will be more sharp. Sometimes this can be useful (for 
example on leather seat material) but usually the better way is just set a value in the range 15-25. 

Add noise 

- this can add noise to the map 

 Metallic color 

- this can add metallic color to the map 

  

 

c.)Saving the file 
Let’s choose save(floppy disc) -> save normals as -> and here we have to pick out the same typ of 
map like in the second method – tiff format. Sometimes map doesn’t want to work (I read that on the 
internet). The way to avoid this is very simple, just reopen the file in Photoshop or another type of 
program and simply save it again and it will work correctly. 

 
How to Create Seamless Textures in Photoshop 

Whether you’re wrapping textures around 3D objects or simply filling a background, it’s likely 
you’ll need to fill a larger space than your original texture block will allow. The problem is how to 
avoid the obvious joins where the texture repeats. Here’s a simple solution that you can use to make 
any texture seamless. 
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Step 1: The starting texture 

Choose your texture, and crop it so that it fits the Photoshop window – you don’t want any of it to 
hang off the canvas. If you have your Crop Tool set so that it doesn’t delete pixels, which is 
standard, then after you’ve cropped Select All and then make a new layer from the selection. This 
will limit the new layer to just what’s visible in the window. 

 

Step 2: Offset the texture 

Drag the texture layer to the bottom left, so the corner of the texture is now more or less in the 
middle. You don’t have to do this precisely. 
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Step 3: Repeat the texture 

Hold Option/Alt as you drag the texture up with the Move Tool to make a copy, holding Shift so it 
moves exactly vertically, until the bottom of the repeated texture meets the top of the existing one. 
Then use Command/Ctrl+E to merge these two layers together. 
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Step 4: Repeat again 

Now drag the layer to the right, again holding Option/Alt and Shift to make a copy. Merge down 
once again. You’ll now have offset the original texture so that the edges are in the middle. The joins 
are obvious here – but you know that where the texture goes off the top, it seamlessly repeats on the 
bottom, and the same for left and right. 

 

Step 5: Patch the joins 

The easiest way to begin is to use the Spot Healing Tool, dragged vertically down the centre and 
horizontally across. This will be a great start, although you’re not there yet. 
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Step 6: Fix the errors 

After using the Spot Healing Tool you’ll probably be left with some unwieldy patches – such as the 
black stone at the top of this image, which looks too cut-off on the right. Switch to the Clone Tool, 
and use it to sample clear patches of background to cover up any anomalies. 
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Step 7: Save the texture 

Select All, then go to Edit > Define Pattern. Give the new pattern a name, and click OK. You’ll now 
be able to use it in any of your Photoshop work. 

 

Step 8: Try it out 

The easiest way to test the new texture is to make a new layer, filled with any flat color, and choose 
Layer > Layer Style > Pattern Overlay. The new texture will be the last one in the list. Once it fills 
the layer, move the dialog out of the way, and you’ll be able to drag it around to check that it really 
is seamless. You can reduce the scale as well, if you like, to check the repeats. 
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65 
 

Unit 3: Texturing in Photoshop and Autodesk MAYA 

1.   Create colourmap  

Process of creating diffuse map in Photoshop 

The diffuse map is a tilable (usally) image which gives the color infomation, but does not contain 
lighting or height information for the texture. It is stored as dds with dxt1 or dxt3 compression for 
use in Doom 3 and as 24 bit TGA (with or without RLE) for the hires repository. 

If your image has lighting baked in (shadows/highlights), you should remove it. 

Photoshop 

Inspect the source image. If you're going to tile it, try to find a regular repeating area. This is only to 
make your job easier. You can tile anything, really, but it depends on how much work you want to 
give yourself. 

After you've chosen a rough tile-able area, crop that area out, and size your image to the desired size 
ratio. Do not go lower than 1024 resolution at this stage of the work, or you'll start losing picture 
quality quickly. So set it to 2048X1024, or 1024X1024, etc. The reason we need to fix the size ratio 
(not the final size) at this stage is for the next step. 

Set the offset 

Go to Filter->Other->Offset. You want to set the horizontal and vertical to be exactly half of your 
cropped picture's width and height. That will make the opposite edges of the texture meet each other 
in the middle of the view, so you can make it really tile-able. 

Make the seams disappear 

See those seams running right down the middle of the pic, vertically and horizontally? You have to 
make them disappear. Get to know the clone tool. (Google...) There are many other ways to shuffle 
pixels too, but I'll leave the specifics up to you. This is usually the hardest, most time consuming 
step. 

Once you've blended the lines away, run the Offset filter again to restore the correct layout of your 
pic, and save it out in a nice high quality (but not too big to manage) format. This is the "diffuse" 
image. We're using 24bit TGA for TDM. 

 

Preparing the Diffuse Map in Photoshop 
Open the Normal map project. 

Add a new layer above the Normal group. Name it ColorBase. Change the foreground color to a 
dark gray. 
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Turn on the Template layer. Go to the ColorBase layer, and fill it with the foreground color. 

 

  

Pick a dark brown color for the foreground, and light brown color for the background.  

On the ColorBase layer, make a selection over the handle grips mesh. Go to Filter/Render/Fibers. 
This will fill in a wood texture for the handles. 

  

 

  

Go to Select/Inverse. This will select all the other pieces which we want to be gray. 
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Keep the selection on and go to Filter/Noise/Add Noise/0.25%. This will add a bit of texture. 

 

  

Save your project as a .PSD file. Turn off the Template layer. Flatten the rest of the layers. Then 
Save As… Diffuse.TGA 

Now check your model in 3ds Max. It is still plain looking, but we will fix that with some layer style 
effects. 
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Layer Style Effects 
Add a new layer. Call it ColorIndents. 

 

  

Open the Normal group. Go to the Indents layer in the Normal group. Use the MagicWand tool and 
click the empty background. Then go to Select/Inverse. The Indents are all selected. 
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Turn off the Normal group, go to the ColorBase layer and go to menu and Edit/Copy. We now have 
a copy of the ColorBase texture inside the selections. 

 

  

Go to the ColorIndents layer. Then go to Edit/Paste Special/Paste in Place. Merge the pasted layer 
into the ColorIndents layer. Now we have the ColorIndents layer filled. 
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Turn on the ColorBase layer and the ColorIndents layer. The pieces blend in. We will use Layer 
Style Effects to the indented areas to add more color to the texture. 

 

  

While on the ColorIndents layer, go to Layer/Layer Style/Inner Glow. Pick a brown color to 
simulate dirt. Blend Mode = Overlay. Size = 10. Noise = 25. 
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Then go to Layer/Layer Style/Outer Glow. Pick a bright grey color to simulate chipped paint. Blend 
Mode = Overlay. Size = 10. Noise = 20. 

 

  

Finally go to Filter/Blur/Blur More. This will smooth the edges of the indented areas. 

Now we have the texture for all the Indented areas. 
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Create two new layers: ColorExtrude1 and ColorExtrude2. 

 

  

Follow these steps: 
ColorExtrude1 layer: 

#1. Get the selection of extruded pieces from Extrude1 in the Normal group of layers. 

#2. Go to the ColorBase layer and Copy. 

#3. Go to ColorExtrude1 and Paste in Place. 

#4. On the ColorExtrude1 layer add an Inner Glow for chipped paint, and an Outer Glow for dirt. 
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#5. Filter/Blur/Blur More. 

  

ColorExtrude2 layer(the rivets): 

#1. Get the selection of extruded pieces from Extrude2 in the Normal group. 

Turn off Anti-alias  

#2. Go to the ColorBase layer and Copy. 

#3. Go to ColorExtrude2 and Paste in Place. 

#4. On the ColorExtrude2 layer add an Inner Glow for chipped paint, and an Outer Glow for dirt. 

For the rivets, we want the Inner Glow to come from the Center, Size=5. 

 

  

#5. Don’t blur. 
Almost finished the Diffuse(Color) map. 
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Ctrl-click all the layers below the Template layer and above the Normalgroup. 

Then right click and go to Link Layers. Under Layers on the menu, Group the layers and rename it 
Diffuse. 
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Highlight All Edges 
Create a new Layer called Alledges. Put it below the Template layer. 

 

  

Open the Diffuse group, and turn off all other layers. Merge the Visible layers. 

 

  

Select the entire screen. Go to Copy on the menu. We just want a copy of this diffuse image. 
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Get the Diffuse group of layers back again. We want to keep the Diffuse group if we decide to make 
any changes there. 

So, CTRL+ALT+Z until you are back the Diffuse group. Now go to the AllEdges layer and then 
Paste from the menu. 

Now we have a copy of the flattened Diffuse group in the AllEdges Layer. 

 

  

Uncheck Anti-alias.  

Go to the Template layer and use the Magic Wand tool to click anywhere outside the Template 
pieces. 
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Go back to the AllEdges layer and press Delete. Now we have all the pieces for the gun model. 

We just have to add a light gray color to all the edges. 

 

  

Make a Duplicate copy of the AllEdges layer. 

Go to the Diffuse group and make a Duplicate copy of the ColorBase layer and drag it under the 
AllEdgescopy layer. 
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Go back to the AllEdges layer. On the menu go to Layer/Layer Style/Inner Glow. White color, 
Noise=20, Size=7. 

All the pieces have a light gray edge. 
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Add a layer mask to the AllEdges layer. Go to Layer/Layer Mask/ Reveal All. 
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Now use the Pencil tool. Size=25. Make the foregroundcolor black.  

On the AllEdges layer, click the layer mask, then use the pencil to erase edges we don’t want to 
show on the model. 

The edges to erase are mostly on the barrel pieces, and the line indent areas on the gun box. 

 
This is the Final Diffuse image. 
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Save your project as a .PSD file. Turn off the Template layer. Flatten the rest of the layers. Then 
Save As… Diffuse.TGA 

 

Un rapping the 3D Polygon Object 

Within Photoshop the standard brush tool can be used to paint directly onto the 3D geometry and 
project the paint marks onto the texture map. 

 

Painting on one face of this particular object will result in the paint appearing on every side. This can 
be quite confusing to why it happens. If the material for cube is opened, it’s fairly obvious why. 

To access the materials for a 3D Object in Photoshop, click on the material object in the 3D menu 
(marked yellow) and select to open/edit the Diffuse texture (marked in red) from the folder (marked 
in purple) 
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It turns out that we only see one face, the reason that we see this result on all faces is that each of the 
other faces takes the texture from a single definition. 
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3D Texture maps are controlled by something called UV’s or UVW (in some cases). A UV is a 
collection of reference points that link texture back to the original Polygons.  The U and V are 
simply references for an X and Y coordinates reference, but are represented in a 2D fashion, this is 
called un-wrapped geometry. These 2D representations will make texturing and painting much 
simpler and more controllable. In the case of the cube there are six faces, so therefore six UV’s exist. 
however, the UV’s in this example are all positioned in the same place, that’s why we only see one, 
but in reality there are six overlapping. 

This might be want you need to paint the cube for your texture, but if you need to have different 
designs, patterns and textures on each face, then this won’t work for you and will need to be 
corrected. 

Photoshop CC can read the UV’s that have been created from a 3D Package and also has a way to 
automatically correct the UV’s by choosing ‘Generate UVs’ from the 3D Menu. This again, might 
be ok for the texture that you would like to paint. However, if you would like to get full control of 
the UV’s, then you will need to unwrap them using a dedicated 3D package. 

There are many different 3D packages out there and one is Cinema 4D and that is what’s explained 
here.  N. B. You will need Cinema 4D Body Paint to do UV unwrapping with your models. 

Within Cinema, you can see the same object that existed in Photoshop CC above.  N.B. This is a 
very simple tutorial and not the only way to perform the unwrapping. 

When you unwrap, you will want to think about how the textures will be laid on the final object. 
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The first thing inside Cinema is to make the object editable, clicking the ‘Make Editable’ button in 
cinema to do this (marked in red below) 

N.B. Make Editable essentially converts the object from parametric (you can still change 
parameters) to polygons. This is typically done when want to edit the points/polygons by hand, edit 
the UVW map, etc. 

 

The next step is to define the points that will be used to refer the object on the UVW map. For the 
cube, move the Cinema view port into top mode. 

Each window has a window selector in the top right (as shown in red below). When on the 
perspective mode as in above, clicking this button (marked in red below), will take you into multi 
view mode, then clicking on the same button on the required view will show it in full screen. 

 

Move Cinema into the Points view (by clicking on the points mode (marked in red). 

On the top view, hold the SHIFT key down and click on each corner of the square. 
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N.B. Points refer to Vertices. Vertices/Points are the collections that hold the polygons/edges of the 
model together. 

 

Now move back to perspective mode in the viewport. 

The 2D representation of the 3D model (or the UV’s) is a flattened version, so obviously when 
converting a 3D object to a 2D representation it will need to be cut in certain places. By selecting the 
edge tool (marked in red), will tell Cinema how to cut the model and lay it down on a 2D surface 
(Similar to when a tailor makes a suit). In the case below, each vertical edge of the cube is selected 
(using the SHIFT key), Cinema will cut the model on each edge. 

 

To unwrap this model as a conventional representation, we need to specify the bottom and how that 
will be cut, bearing in mind how it will be unfolded. We will just specify three sides to cut, leaving 
the 4th connected to the uncut faces. (Holding the SHIFT key will ensure that these are selected as a 
collection, if the wrong edge is selected, then pressing CMD/CTRL will allow you to remove a 
single edge from the collection). 
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Now, we can unwrap the model into the 2D UV. 

The object marked in Red shows that the model has a UV map assigned to it. To access this, change 
the view port to be in BP UV  

Edit.   

When inside the BP UV Edit, you can select ‘UV Mesh / Show UV Mesh’, and in this case, the lines 
shown in the yellow box below, will be the same as what Photoshop is showing. 
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Move Cinema into the top view, as we are now going to specify on the UV where the selected points 
are. To start specifying the UV, click the UV property (marked in red), then move the viewport into 
UV mode (marked in yellow). As long as a UV property exists the area marked in purple will 
become active). 

 

There are many variataions to the next step, but for this we are specifying the points, so just click the 
Projection / Frontal. This will take the points and represent them on the UV (show below). 
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Move cinema into perspective view and click the Relax UV tab. 

Make sure the ‘Pin Point selection’ is turned on (but the use tag is turned off), as we will use the 
active selection, not a saved selection. And make sure that ‘Cut Selected Edges’ is turned on (but the 
use tag is turned off), for the same reason as just mentioned. Also, make sure that LSCM is selected, 
as well as having Auto re-align turned on. 

 

Then click on Apply! 

Hopefully the 2D UV will be shown on the right hand side, which will have collapse all six surfaces 
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Save the Object and export as either Collada 1.4 or OBJ from Cinema 4D, then open into Photoshop 
CC. Now painting on the 3D model or on the 2D UV map by using the standard Photoshop CC brush 
tool, should be much easier and each side can be painted independently. 
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2.   Create bump map and use de saturate command 

 Creating bump in MAYA map in MAYA 

Bump maps are grayscale textures you map to objects to create the illusion of surface relief 
(elevations and depressions) on an otherwise flat object. 

With bump maps, depressions and elevations look real because they don’t alter the geometry of the 
surface the way Displacement maps do. Bump maps just change the direction of the surface’s 
normals based on the bump map’s Alpha Gain value. 

Use bump maps to create very shallow reliefs. For example, you can make objects look like they are 
embossed, have shallow rolling hills, and so on. 

Because bump maps are not true surface relief, they: 

• cannot cast or receive shadows 

• cannot be seen if you silhouette the mapped object 

• take less time to render than displacement maps 

Tip: 
• Although scratches are like little depressions, you can more easily achieve them with 2D 

textures. 

How to Sharpen Images 

There are hundreds of suggestions, tips, and methods for sharpening images. My favourite technique 
for sharpening uses Photoshop to create a high pass layer and then layer masks to control where and 
how much sharpening is applied. 

A high pass layer works in the same way an unsharp mask works on film: the high pass layer creates 
slightly blurry halos around edges in the original image, thus increasing the contrast at edges. The 
difference between high pass sharpening and most other methods of sharpening is that high pass 
sharpening does not actually adjust or change any pixels in your original image. Also, because high 
pass exists as a separate layer, you can adjust the layer’s Opacity and Blending Modes to control 
the strength of sharpening over the entire image. You can then use masks to control where 
sharpening is applied within the image and to make localized changes in the strength of sharpening. 

Another advantage to sharpening with a high pass layer is you can save the layer with the Photoshop 
file and go back later and change the settings and areas where sharpening has been applied. This is a 
huge advantage when working with an image that you might finish for web viewing and printing, or 
printing on different papers. 



91 
 

Let’s get started.  

Step 1: Evaluate Your Image 
I’m going to sharpen the image below. I want to bring out the details in the back left corner (in the 
circle) and prevent the details in other places (at the arrows) from becoming overly sharp. If I let the 
artwork at the back of the window display become too sharp, the background will distract from the 
foreground. If I let the edges of the eyes in the centre mask become too sharp, the mask will look 
painful to wear. Overall, I’ll need to prevent the colours from clumping and the details from 
breaking down as a result of too much sharpening. 

 

Step 2: Stamp New Layer or Duplicate Your Image Layer 
Sharpening is usually the last or almost the last thing you do when preparing an image, and you want 
to be sure that you are applying sharpening to a finished, complete image. Therefore, before making 
your sharpening layer, ensure you have a duplicate layer of your completed image.  

If your work is all on one layer, then just duplicate that layer (Command-J/Control-J). If, however, 
you’ve been working on a few layers, then merge the layers together into a new layer. In Photoshop, 
this is called Stamp New Layer.  

To Stamp New Layer, check that all layers you want included in your final image are visible 
(turned on). Click on (select) your topmost layer and then stretch your fingers to use Command-Alt-
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Shift-E/Control-Alt-Shift-E to activate the Stamp Visible command and make that stamp a new 
layer. (There is no menu item for this command.) 

You now have a flattened version of your final image while preserving all of your independent 
layers. In addition to allowing you to sharpen without making changes to your image, creating this 
layer allows you to still access your original layers to make further changes, should you wish. 

To keep your work organized, rename your new merged layer “High Pass Sharpening.” 

 

Step 3:Desaturate the High Pass Layer 
A disadvantage to sharpening with a high pass layer is the potential for increasing or adding noise to 
a photo. With other sharpening tools such as Unsharp Mask, you can control noise problems with 
adjustments to the different values set in the tool. With the high pass option, you control noise by 
doing three things: 

• Ensure your image capture is as clean as possible. This means using a tripod if not shooting 
at a high shutter speed, choosing the lowest ISO possible, and using the correct exposure. 

• Deal with any noise while processing your image.  
• Desaturate the high pass layer. Even when working on a colour image, the colour information 

in a high pass layer is irrelevant, so we’re going to remove that information right from the top 
to ensure that extra information doesn’t add noise.  

Because we don’t need to preserve an adjustment layer, desaturate the high pass layer by going 
to Image > Adjustments > Desaturate or use the shortcut Command-Shift-U/Control-Shift-U. 



93 
 

 

Step 4: Apply the High Pass Filter 
To apply the high pass filter to your sharpening layer, go to Filter > Other > High Pass.  

This will bring up a dialogue box with a Radius slider. You want to increase the Radius slider 
(increase the number of pixels affected) until the details in the image just begin to pop. You’ll find 
you need more Radius when you’re working with high resolution images. Don’t be surprised if you 
need around 10 to 20 pixels or more. Select OK. 
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top image has not been sharpened enough; the details appear to be behind a veil. The middle image 
has been sharpened too much; large patches of colour on the centre mask - which are not edges - are 
popping. The bottom image has been sharpened correctly for the area that needs the most sharpening 
(the back left of the image). In that area, the details are just beginning to pop through the layer of 
grey. 

Step 5: Set the Layer’s Blending Mode 
Change the layer’s blending mode in the blending options drop down menu to Soft Light. As you 
become more familiar with using high pass sharpening, experiment with Hard 
Light and Overlay blending modes as well. 

Step 6: Adjust the Layer Opacity 
You will likely find that you now have a bit more sharpening than you need. That’s okay; starting 
with 100%, adjust the Layer Opacity down to get the amount of sharpening you need. Aim for an 
opacity that gives you the right amount of sharpening in the area of your image that needs the most 
sharpening. 

 

Step 7: Mask the Layer As Needed 

Add a layer mask by clicking on the Layer Mask icon at the bottom of your Layers window, or by 
going to Layer > Layer Mask.  

Depending upon how much sharpening you’re going to need, you have three options: 
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• If you need sharpening in many places, add a white layer mask (Reveal All or click on 
the Layer Maskicon a the bottom of the Layers window), then paint out what you don’t 
need with a black brush. 

• If you need sharpening in just a few places, add a black layer mask (Hide All or Alt-click if 
you’re adding a mask with the Layer Mask icon) and paint in what you need with a white 
brush. 

• If you will both add and take away sharpening, add a white layer mask (Reveal All or click 
on the Layer Mask icon a the bottom of the Layers window), then fill the mask with 50% 
grey. (Set the Foreground colour to 50% grey and with the layer mask active, use Alt-
Delete to fill the mask.) Paint in what you do need with a white brush and paint out what you 
don’t need with a black brush. 

To begin adding or removing sharpening, ensure your colours are set to the default Foreground and 
Background (D). Use a very soft brush (0% Hardness) at a medium or larger size. Paint in or out 
sharpening as you need. Change the Opacity of your brush to control how much sharpening you 
paint in or out. 

Turn on and off visibility of the high pass layer while you work in order to check the changes you’ve 
made. It’s better to not apply quite enough sharpening than to over sharpen an image. Avoid creating 
edges that become unnaturally razor sharp or causing colours to clump. The dreaded sharpening 
halos are not as obvious with high pass sharpening as they are with other sharpening tools, so you 
may not see them before you notice the other two changes.  

I chose 
to fill my mask with 50% grey and then both paint in and out sharpening as I needed. As I finished, I 
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realized that I wanted a bit more general sharpening across the whole image, so I lowered the opacity 
of the layer mask, effectively applying more sharpening over the whole image. 

Finishing Up 

If you discover after you’ve sharpened that you need to make other changes in your image, you can 
still work on the adjustment layers beneath without having to redo the sharpening. You will only 
have to redo the sharpening layer if you change the actual content of your image by, for example, 
cloning. 

Once I 
finished sharpening my image, I concluded that my image was slightly oversaturated, so before 
outputting my final image, I made an adjustment in the Hue/Saturation layer that was beneath the 
High Pass Sharpening layer. 
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3.   Create specular map 

Use of specular maps 

By mapping a texture to the Specular attribute of an object’s material, you create a specular map 
which lets you describe how shine appears on objects (by controlling highlight). 

Common surface material Specular Shading attributes 
Some surfaces are shinier than others (for example a wet fish has a shinier surface than a dry leaf). 
Depending on how shiny a surface is, it reflects light in different ways. 

Shiny objects reflect light directly; matte objects diffuse light. Specular highlights show the places 
on the object where the light sources are reflected at consistent angles; reflections on an object show, 
among other things, light bounced from surrounding objects. 

Specular highlights depend directly on the view (camera), not the position of the light, like diffuse 
shading does. 

The size of a specular highlight on a surface makes the surface look either flat or shiny. 

Note: Only materials with specular attributes ( Anisotropic, Blinn, Phong , and PhongE) have 
surface highlights. The specular highlight is the white shiny glow on the material. 

 

Tip: 
The Blinn material is recommended for shiny surfaces in animations. Highlights on other specular 
materials, like Phong and PhongE, may flicker when animated. 

For material-specific specular shading attributes, see the particular material.  

Specular Color 
The color of shiny highlights on the surface. A black Specular Color produces no surface 
highlights. The default color value is 0.5. 

 
Tip: For glossy plastic surfaces, use a whitish Specular Color. For metallic surfaces, use 
a Specular Color similar to the surface color. 
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Reflectivity 
Gives the surface the ability to reflect its surroundings or the Reflected Color (similar 
to Specular Roll Off). The valid range is 0 to infinity. The slider range is 0 (no reflections) to 
1 (clear reflections). The default value is 0.5. 

 
Reflectivity values for common surface materials are car paint (0.4), glass (0.7), mirror (1), 
chrome (1). 

Note: 
• For the Anisotropic material, you must turn off Anisotropic Reflectivity to change this 

value. 

• Real reflections are only calculated during raytracing. 

• If you are doing raytracing and you want other objects in the scene to be seen in 
reflections, then for those objects you must ensure the Visible In Reflectionsattribute is 
turned on in the Render Stats section of the Attribute Editor. (It is on by default.) 

Reflected Color 
Represents the color of light reflected from the material. When raytracing, Maya multiplies 
the color with the light color reflected mirror-like from the surface. This can be used to tint a 
reflection. 

If you are not raytracing, you can map an image, texture, or environment map to 
the Reflected Color attribute to create fake reflections, which is faster and uses less memory 
than raytracing. This is called reflection mapping. 

 

Specular 

Weight 

The specular weight. Influences the brightness of the specular highlight. 
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0 0.5 1 (default) 

 

Color 

The color the specular reflection will be modulated with. Use this color to 'tint' the specular 
highlight. You should only use colored specular for certain metals, whereas non-metallic surfaces 
usually have a monochromatic specular color. Non-metallic surfaces normally do not have a colored 
specular. 

 

 

 

 

Red Green Blue 

 

Roughness 

Controls the glossiness of the specular reflections. The lower the value, the sharper the reflection. In 
the limit, a value of 0 will give you a perfectly sharp mirror reflection, while 1.0 will create 
reflections that are close to a diffuse reflection. You should connect a map here to get variation in 
the specular highlight. 
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0.2 (default) 0.4 0.6 

The 'microscopic' features of a surface affect the diffusion and reflection of light. This 'micro 
surface' detail has the most noticeable effect on specular reflections. In the diagram below, you can 
view parallel lines of incoming light commence to diverge when reflected from rougher surfaces 
when each ray hits a part of the surface with a different orientation. In summary, the rougher the 
surface becomes, the more the reflected light will diverge or appear 'blurred.' 

 

'Microsurface' detail represented as a general measure of roughness (this surface would have a high Specular Roughness value). 

  

The brightness of the Specular highlight is automatically linked to its size due to the Standard 
Surface Surface shader's energy conserving nature. In the example below, all of the materials are 
reflecting the same amount of light, but the rougher surface is spreading it out in multiple directions. 
However, with low amounts of roughness, the surface is reflecting a more concentrated amount of 
light. 

 

 

 

 

0.1 (default) 0.4 0.6 
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To get variation in the highlights of the surface, a map should be connected to the Specular 
Roughness. This will influence not only the brightness of the highlight but also its size and the 
sharpness of the environmental reflection. 
You may need to connect the file texture to a Range shader to see any results in the Specular 
Roughness. 

 

 

 

 

0 0.5 1 

Fingerprint texture -> Specular Roughness 
The specular roughness affects both specular reflection and refraction. There is also a Transmission 
Extra Roughness parameter to add some additional roughness for refraction if required. You can, 
however, use Coat to create a rough reflection layer over a sharp refraction. 

 

 

 

0 0.5 1 
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Out Color R of file texture connected to Specular Roughness 

  

IOR 

The IOR parameter (Index of Refraction) defines the material's Fresnel reflectivity and is by default 
the angular function used. Effectively the IOR will define the balance between reflections on 
surfaces facing the viewer and on surface edges. You can see the reflection intensity remains 
unchanged, but the reflection intensity on the front side changes a lot. 

 

 

 

1 1.1 1.5 (default) 

 
Using a very high IOR value can look quite similar to Metalness. It looks the same if you set 
the Base Color to the Specular Color and the Specular Color to black. The difference is that you get 
an extra reflection at the edges, with the Specular Color controlling the edge tint. The metal fresnel 
works the same as in the new complex IOR shader, with the artistic parameters. 

You should normally use IOR for materials like plastic, glass, or skin (dielectric fresnel) 
and Metalness for metals (conductive fresnel with Complex IOR). The other reason is 
that Metalness is easier to texture since it's in the 0..1 range, and using textures from applications 
like Substance painter works best when using Metalness rather than IOR. 

Specular IOR with Transmission 

The default value of 1.0 is the refractive index of a vacuum, i.e., an object with IOR of 1.0 in empty 
space will not refract any rays. In simple terms, 1.0 means 'no refraction'. The Standard 
Surface shader assumes that any geometry has outward facing normals, that objects are embedded in 
the air (IOR 1.0) and that there are no overlapping surfaces.  

 

 

 

 

 

1 1.1 1.2 1.3 1.4 1.5 
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1 1.5 (default) 

Normals 

When rendering refractive surfaces, it is very important that the normals of the geometry face in the 
right direction. In the example below (left), you can see the difference between normals that are 
facing in the right direction (outward), versus those that are facing inwards (incorrect). This is 
especially important when rendering surfaces with double-sided thickness, such as glass. However, 
with air bubbles in glass (below center), the reverse is true. The bubble geometry normals should be 
reversed and the bubbles should be combined with the glass geometry. Normal direction is equally 
important when rendering single sided surfaces such as a car windscreen (right). 

   

Normals pointing outward (correct). Rollover image to 

view normals pointing inward (incorrect). 

Air bubbles in glass: Normals should point 

inward. Rollover image to view normals 

pointing outward (incorrect). 

Windscreen model (single sided). 

Rollover image to view normals 

pointing inward (incorrect). 

If you see any black where there should be refraction, you may not have a high enough Transmission 
Ray Depth value (found in the Ray Depth section in the render settings). The default value is eight, 
which is sufficient for most cases. 

Anisotropy 

Anisotropy reflects and transmits light with a directional bias and causes materials to appear rougher 
or glossier in certain directions. The default value for Anisotropy is 0, which means 'isotropic.' As 
you move the control towards 1.0, the surface is made more anisotropic in the U axis. 
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0 (default) 0.6 0.9 

Anisotropy is suitable for materials that have a clear brush direction such as brushed metal which 
has tiny grooves in which form a 'stretched' anisotropic reflection. 

 
Many small discs form together to create an effect which is the anisotropic highlight 

   

0.3 0.6 0.9 

  

Anisotropic reflections are suitable for brushed metal effects such as in the example below:  
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Texture assigned to Anisotropic Rotation 

  

  
You may notice faceting appear in highlights when using Anisotropy. It is possible to remove the 
faceted appearance by enabling smooth subdivision tangents (via Arnold subdiv_smooth_derivs 
parameter). Take into account this requires a subdivision iteration of at least one in the polymesh to 
work. 

 

Faceting seen in the anisotropic highlight Subdivision: enabled. Subdivision 
Iterations: 1. Smooth Tangents: enabled. 

Increase Subdivision Iterations to remove anisotropic faceting. 
More information about Specular 'Anisotropy' can be found here. 

Rotation 
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The rotation value changes the orientation of the anisotropic reflectance in UV space. At 0.0, there is 
no rotation, while at 1.0 the effect is rotated by 180 degrees. For a surface with brushed metal, this 
controls the angle at which the material was brushed. For metallic surfaces, the anisotropic highlight 
should stretch out in a direction perpendicular to the brushing direction. 

   

 

 

0 (default) 0.25 0.5 0.75 1 

It is possible to assign textures to the rotation. When doing so, it is advisable to avoid texture 
filtering. This means disabling MIP-mapping and disabling the magnification filter, which by default 
is set to "smart bicubic." One way is to set the mipmap_bias of the image node to a strong negative 
value, like -8, which means "use 8 MIP levels higher resolution than usual". 

Mipmap bias set to 0. Filtering 
set to Bicubic. 

Mipmap bias set to -8. Filtering 
set to Bicubic. 

No Mip-mapping. 
Magnification filter set to 

closest. 
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Arnold filter attributes found under Maya file node 
 

  Export the UV map to Adobe Phtoshop and paint the Texture on UV map 

Sometimes it’s necessary to have a 2D Texture Template for a 3D model. It makes texturing a lot 
easier in 2D painting apps. 

While some programmes like Marvelous Designer can create the UVs, and quite clearly show them 
to us, there’s no easy way to export them as a flat file – akin to the one you see on the right here.  

Photoshop to the rescue! All versions of Photoshop 3D and Photoshop CC can import OBJ files, and 
they can not only display the UV Map as an overlay, they can turn it into a new Layer for us as well.  

Here’s how to do it.  

Displaying the UV Map as an overlay 

Import a UV mapped and perhaps even textured OBJ file into Photoshop. You’re greeted with a 3D 
View of the object, and a small thumbnail of it in the Layers tab. I’m using the Marvelous Designer 
default dress for this demo. 
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Notice the Diffuse Texture Map underneath the thumbnail. Mine is called c_broadcloth_maroon 
because that’s the texture file my OBJ references. Depending on your OBJ, there may be other maps 
applied here as well. 

Double-click the diffuse texture anywhere right to the little eye icon (eyecon… har har har) and a 
new document PSB document opens, showing you the flat texture. This allows for easy changes. 
Right now all we see here is a Background Layer, with no indication of how the object is 
unwrapped. 

In the Properties Palette, under 3D Paint, find a checkbox that reads UV Overlays. When ticked, 
Photoshop will display the UV Map on top of the current image. How cool is that? 
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While this is a great help for painting textures, the overlay is presented much like a guideline or a 
ruler – it’s not exportable as such. We’ll see how to do that next. 

Turning the UV Overlay into a Layer 

Untick the UV Overlays checkbox for now and see the UV Map disappear again. What we really 
want is that overlay baked into our image, preferably as a layer. And of course that’s possible with 
Photoshop. 

Head over to 3D – Create Painting Overlay – Wireframe will do just that. 

 

Selecting this will create a new layer with the same UV Map as we’ve just seen. This is your UV 
Texture Template. 

If you find that the current map isn’t big enough, simply resize the image to your liking and create 
the UV Overlay layer again to match your new texture size. 
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4.   Demonstrate knowledge of creating seamless textures 

To apply a texture to an object, you map the texture to an attribute on the object's material. The 
attribute to which the texture is connected determines how the texture is used and how it affects the 
final results. 

For example, if you connect Maya’s 2D black and white Checker texture to the color attribute of an 
object’s material, you have applied a color map; the checkered pattern determines which parts of the 
object appear black and which appear white (or other colors if you adjust the texture’s color 
attributes). 

 

If you connect the black and white Checker texture to the transparency attribute, you have applied a 
transparency map; the checkered pattern determines which parts of the object are opaque and which 
are transparent. 

 

Commonly used texture maps 

Color maps 

By mapping a texture to the Color attribute of an object’s material, you create a color map which 
describes the color of the object. 

The following attributes are common to most surface materials. 

For material-specific specular shading attributes, see the particular material. For example, for 
information on the specular shading attributes of the Anisotropic material, see Anisotropic. 



113 
 

Type 
The material’s basic type (such as Blinn or Phong). 

When you change a material’s type, only those attributes common to both types retain their 
previous values or settings. For example, if you change the material type from Blinn (which 
has a Color attribute and a Specular Color attribute) to Lambert (which has a Color attribute 
but no Specular Color attribute), the Color setting is preserved, but the Specular Color setting 
is lost. 

Color 
The default material color. 

You can work with color in Maya in so many different ways. Here are some of the most 
common: 

• Change the basic color of an object by adjusting the color attribute of a material applied 
to the object. See Set a color for the object for a visual demonstration. 

• Apply a texture as a color map to the material’s color attribute. See Map a texture to any 
of the material attributes for a visual demonstration, and Map a 2D or 3D texture to a 
material for more information. 

• Use a Ramp Shader for extra control over the way color changes with light and view 
angle. You can simulate a variety of exotic materials and tweak traditional shading in 
subtle ways. 

• Expand, enhance, or manipulate colors in applied textures using utilities such as Blend 
Colors, Clamp, Gamma Correct, and so forth. For example, you can blend colors, adjust 
contrast, and convert HSV to RGB. For a description of each of the utilities and what you 
can use them for, see Utility nodes. 

Transparency 
A material’s color and level of transparency. For example, if the Transparency Value is 0 
(black), the surface is totally opaque; if the Transparency value is 1 (white), the surface is 
totally transparent. 

To make an object semi-transparent, set the Transparency color to a shade of grey or to the 
same color as the material Color. The default value is 0 (black). If you 
change Transparency from the default black (0), the background of the 
material’s Hypershadeswatch becomes a checkered pattern. This is a visual aid and is not 
rendered. 

You can work with the transparency of an object in the following ways: 

• Change the transparency level of an object adjusting the transparency attribute of a 
material applied to the object. 

• Apply a texture as a transparency map to the material’s transparency attribute to 
designate which areas of an object are opaque, transparent or semi-transparent. 
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Note: If the material has specular highlights the transparency setting do not affect the 
highlights. So if you are trying to make an object disappear by animating the transparency 
attribute, you may also have to animate the specular highlight attributes. 

Ambient Color 
Set to black by default, which means it does not affect the material’s Color. As the Ambient 
Color becomes lighter, it affects the material’s Color by lightening it and blending the two 
colors. If there are ambient lights in the scene, the color and brightness of those lights is used 
to control how much the ambient color contributes to the final color of the material. 

Incandescence 
The color and brightness of light that a material appears to be emitting. (Incandescent objects 
do not illuminate other objects.) For example, to simulate lava, use a bright 
red Incandescence. The default color value is 0 (black). 

Tip: 
• Although incandescence makes a surface appear to glow, it does not actually act as a 

source of light in the scene. 

• Use a little Incandescence for vegetation to make it look organic. 

Bump Mapping 
Makes the surface appear rough or bumpy by altering surface normals (during rendering) 
according to the intensity of the pixels in the bump map texture. A bump map does not 
actually alter the surface. A silhouette of the surface appears smooth. 

For more information about bump mapping, see About surface relief. 

Diffuse 
Gives the material the ability to reflect light in all directions. The Diffuse value acts like a 
scaling factor applied to the Color setting—the higher the Diffuse value, the closer the actual 
surface color is to the Color setting. The valid range is 0 to infinity. The slider range is 0 (no 
light is reflected in all directions) to 1, but you can type in a higher value. The default color 
value is 0.8. 

Translucence 
Gives the material the ability to transmit and diffuse light. Light falling on a translucent 
surface is first absorbed beneath the surface, and then diffused in all directions. If set to 0, the 
default, no light shows through the object. If set to 1, all the light shows through. The default 
value is 0. 

Tip: 
Use Translucence to simulate clouds, fur, hair, marble, jade, wax, paper, leaves, flower 
petals, or frosted light bulbs. 

Note: 
• The Translucence value of a surface lit by a non-shadow-casting light is zero or infinite 

(all non-zero values). 
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• If the scene combines a translucent surface with a shadow casting spotlight, faint grid-
like artifacts may become visible. If this happens, increase the spotlight Filter Size or 
lower the Resolution. 

• For high values of Translucence, lower Diffuse accordingly to avoid washout. 

• A surface’s actual translucence is based on the illumination it receives from lights, and is 
not related to its transparency. However, as an object becomes more transparent, its 
translucent (and diffuse) illumination gets dimmer. 

• Ambient lights have no effect on translucent (or diffuse) illumination. 

Translucence Depth 
Simulates the way light diffusely penetrates through translucent objects. For example, when 
light shines on one side of the object, the other side is partially illuminated. This can be used 
for effects such as clouds, fur, hair, marble, jade, wax, paper, leaves, and so on. (To see this 
effect, turn on raytraced shadows for the light shining on the object.) 

Translucence depth is based on worldspace. If it is set to 0 (the default), no light shows 
through the object. If set to 10, light penetrates through the surface, 10 units past the point 
where the object is in shadow. 

Tip: 
To see the effects of translucence depth, set the transparency to a non-zero value. If the 
surface is supposed to be opaque, set the transparency to a very small value, such as 0.0001. 

Translucence Focus 
The Translucence Focus value controls how much translucent light is scattered depending on 
the direction of the light. 

 
For example, use a high value for very thin materials, such as wax paper or steam, where 
most of the light is scattered over a small angle relative to the light’s direction. The object 
looks brightest with the light source directly behind it. 

Note: 
When a spotlight is used to light an object with a translucent material, the light does not 
scatter past the light's cone of influence, even if Translucence Focus is lowered. 
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Use a mid-range focus value for items such as leaves. The leaves glow when backlit, but do 
not wash out when lit from the front. 

 
Use a low focus value for thicker objects, such as wax. To compensate for the added light 
and avoid a washed out result, lower the diffuse value, or lower the overall color (which also 
affects ambient lighting). 

 
Tip: 
Lower the color value for very shiny objects that have a bright specular component. 

 

Transparency maps 
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By mapping a texture to the Transparency attribute of an object’s material, you create a transparency 
map which lets you make parts of an object opaque, semi-transparent, or entirely transparent. 

Specular maps 

By mapping a texture to the Specular attribute of an object’s material, you create a specular map 
which lets you describe how shine appears on objects (by controlling highlight). 

Reflection maps 

By mapping a texture to the Reflected Color attribute of an object’s material, you create a reflection 
map which lets you describe how an object reflects its surroundings. 

Create true reflections 
  
Note: 
To create true (photorealistic) reflections, you must raytrace the scene, a process which can take a 
significant amount of time. For more information about raytracing, see Depth map and raytraced 
shadows. 

You must have at least two surfaces to create true reflections (or a surface that somehow curves 
around so one part of its surface can reflect onto another part of its surface). 

You can control which surfaces appear in reflections and which don’t by turning Visible in 
Reflections on or off in each surface’s Attribute Editor. (Visible in Reflections is on by default when 
you create new surfaces.) 

To create true reflections (example) 

1. Create a sphere and a plane, and position the sphere over the plane. Create a light to illuminate 
both surfaces. 

2. Create a specular material (a Phong or PhongE) and assign it to the sphere. The sphere is 
reflected in the plane. 

3. Create a second material and assign it to the plane. The plane reflects the sphere. 

4. Make each surface a different color so you can see the reflection of one in the other. 

5. In the Raytracing Quality section of the Render Settings window, turn on Raytracing. 

This tells Maya to raytrace any surface whose Visible in Reflections/Refractions is toggled on. 
These attributes are on by default for all surfaces, but raytracing only works when you turn 
on Raytracing in the Render Settings window. 

To learn more about the Render Settings, see Render Settings window. 

6. Perform a test render to visualize the results. If you want the sphere to reflect the plane, open the 
plane’s Attribute Editor and turn on Render Stats > Visible in Reflections. 
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To test iterations of a scene, see Visualize interactively with IPR. 

Bump maps 

By mapping a texture to the Bump attribute of an object’s material, you create a bump map which 
lets you add the illusion of surface bump detail to a surface. 

Displacement maps 

Displacement maps let you add true dimension to a surface at render time, a process which may 
reduce or eliminate the need for you to create complex models. 

 

Displacement maps are grayscale textures you map to objects to create true surface relief (elevations 
and depressions) on an otherwise flat object. 

With Displacement maps, depressions and elevations become part of the geometry of the object, 
changing the topology, unlike Bump maps that only create the illusion of surface relief. 

Note: 

• Because displacement changes the geometry of an object, displacement mapped objects usually 
require further tessellation (more triangles, which the renderer uses to approximate the 
smoothness of the surface). By default, Maya uses Feature-based displacement mapping to 
automatically add more triangles where required. 

• File textures that are used for displacement mapping are usually connected via 
their outAlpha attribute. If the corresponding texture image file does not provide an alpha 
channel, then the displacement effect may be missing when using certain image formats. To 
avoid this, turn on the Alpha is Luminance attribute in the Color Balancesection of the File 
Texture node. For more information, see File. 

Displacement maps move an object’s vertices. By default, the height of the displacement is 
determined by the Alpha Gain value in the displacement map’s Attribute Editor. If you turn 
on Alpha is Luminance, the height result is based on the intensity of the pixels instead. 

Use displacement maps to create shallow or deep surface relief. For example, you can create 
embossing, mountain peaks and valleys, spikes, and so on. 
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Because Displacement maps create true surface relief, they: 

• can cast or receive shadows 

• can be seen if you silhouette the object 

• take more time to render than bump maps, which create the illusion of surface relief 

Note: 
You can connect a texture as a displacement map by connecting it to the Displacement mat attribute 
in the material’s shading group. See Connect a texture as a displacement map for more information. 

Displacement Bounding Box 

Because displacement mapping changes the volume of an object, it’s bounding box may become too 
small or too large. 

Bounding boxes, which represent the bounding volume of an object, can be used to speed up Maya 
operations and can make a significant difference for complex models. 
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